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	WEEK 3
	

	
	
	Autobiography
	
	Biography
	
	Magazine Article
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	Reaching for the Moon

	
	Rare Treasure: Mary 
Anning and Her 
Remarkable Discoveries
	“Twins in Space” from Ask Magazine

	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Minilesson 
Bank
	Map: Discover Extraordinary Iceland
	RI.4.7
	Infographic: Where We Live
	RI.4.7
	Media: Everyday Space Technology
	RI.4.7

	
	
	Narrative Nonfiction: Reaching for the Moon
	RI.4.10
	Biography: Rare Treasure: Mary Anning and Her Remarkable Discoveries
	RI.4.10
	Magazine Article: “Twins in Space” from Ask Magazine
	RI.4.10

	
	
	Words About People and Events
	L.4.5
	Words About People and Events
	L.4.5
	Domain-Specific Vocabulary
	L.4.4.c

	
	
	Explain Author’s Purpose
	RI.4.8
	Analyze Main Idea and Details
	RI.4.2
	Analyze Text Structure
	RI.4.5

	
	
	Use Text Evidence
	RI.4.1
	Generate Questions
	RI.4.10
	Evaluate Details
	RI.4.2

	
	
	Talk About It: Opinion
	SL.4.1.d
	Write to Sources: Opinion
	W.4.9
	Write to Sources: Response
	W.4.9

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.4.4.c
	Synonyms and Antonyms
	L.4.5.c
	Context Clues
	L.4.4.a

	
	
	Word Study
	Suffixes -ed, -ing, -s, -er, 
-est
	RF.4.3.a
	Suffixes -ity, -ty, -ic, -ment
	RF.4.3.a
	Syllable Pattern VCe
	RF.4.3.a

	
	
	Read Like a Writer
	Analyze Author’s Use of Graphics (Illustrations)
	RI.4.7
	Analyze Figurative Language
	L.4.5.a
	Analyze Text Structure
	RI.4.5

	
	
	Write for a Reader
	Use Graphics (Illustrations)
	W.4.3.a
	Use Figurative Language
	W.4.3.d
	Use Text Structure
	W.4.2

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Personal Narrative
	W.4.3
	Portray People
	W.4.3.a
	Develop and Compose an Introduction
	W.4.3.a

	
	
	Know the Narrator
	W.4.3.a
	Compose a Setting
	W.4.3.b
	Compose an Event Sequence
	W.4.3.a

	
	
	Know the Setting and Events
	W.4.3.a
	Develop an Idea with Relevant Details
	W.4.3.b
	Use Transition Words and Phrases
	W.4.3.c

	
	
	Brainstorm and Set a Purpose
	W.4.5
	Use Concrete Words and Phrases
	W.4.3.d
	Compose Dialogue
	W.4.3.b

	
	
	Plan Your Personal Narrative
	W.4.5
	Compose with Sensory Details
	W.4.3.d
	Develop and Compose a Conclusion
	W.4.3.e

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Words with Suffixes 
-ed, -ing, -s, -er, -est
	L.4.2.d
	Spell Words with Suffixes 
-ity, -ty, -ic, -ment
	L.4.2.d
	Spell Syllable Pattern VCe
	L.4.2.d

	
	
	Language and Conventions
	Subjects and Predicates
	L.4.1.f
	Compound Subjects and Predicates
	L.4.1
	Complete Sentences
	L.4.1.f



 (
UNIT 1 
SKILLS OVERVIEW
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
Essential Question
)
How can a place affect how we live?
	WEEK 4
	
	WEEK 5
	

	Informational Text
	
	Biography
	

	Life at the Top


	
	Barbed Wire Baseball


	

	
	CCSS
	
	CCSS

	Infographic: Cool Homes Around the World
	RI.4.7
	Primary Source: Taking Care of Our Land
	RI.4.10

	Informational Text: Life at the Top
	RI.4.10
	Biography: Barbed Wire Baseball
	RI.4.10

	Precise Words About a Topic
	L.4.6
	Domain-Specific Vocabulary
	L.4.6

	Analyze Text Features
	RI.4.7
	Analyze Text Structure
	RI.4.3

	Confirm or Correct Predictions
	RI.4.10
	Summarize a Text
	RI.4.2

	Write to Sources: Compare and Contrast
	W.4.9
	Talk About It: Opinion
	SL.4.1.c

	Figurative Language
	L.4.5.a
	Parts of Speech
	L.4.4

	Vowel Teams and Digraphs
	RF.4.3.a
	Prefixes mis-, en-, em-
	RF.4.3

	Analyze Author’s Use of Graphics
	RI.4.7
	Analyze Author’s Purpose
	RI.4.8

	Use Graphics
	W.4.2
	Develop Author’s Purpose
	W.4.3

	Writer’s Craft
	Publish, Celebrate, and Assess

	Add Ideas for Coherence and Clarity
	W.4.5
	Edit for Irregular Verbs
	W.4.5

	Delete Ideas for Coherence and Clarity
	W.4.5
	Edit for Punctuation Marks
	W.4.5

	Edit for Adjectives
	L.4.1.d
	Publish and Celebrate
	W.4.3

	Edit for Adverbs
	L.4.1.a
	Prepare for Assessment
	W.4.3

	Edit for Pronouns
	L.4.1.a
	Assessment
	W.4.3

	Spell Words with Vowel Teams and Digraphs
	L.4.2.d
	Spell Words with Prefixes mis-, en-, em-
	L.4.2.d

	Fix Run-On Sentences
	L.4.1.f
	Fix Sentence Fragments
	L.4.1.f
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	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_6.png][image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_4.png]Inquiry and Research
	

	Make It a Landmark!


	

	
	CCSS

	
	

	Use Academic Words
	L.4.6

	Explore and Plan: Argumentative/Opinion
	W.4.7

	Conduct Research: Field Research
	W.4.7

	Argumentative Texts: Argumentative Brochure
	W.4.7

	Refine Research: Primary and Secondary Sources
	RI.4.6

	Extend Research: Incorporate Media
	SL.4.5

	Revise Sentence Structure
	W.4.5

	Edit and Peer Review
	W.4.5

	Celebrate and Reflect
	SL.4.4




 (
RI.4.2, RI.4.3, RF.4.3.a, W.4.1.a, SL.4.1.b, L.4.2.d
) (
RI.4.1, RI.4.7, RF.4.4, SL.4.1, L.4.4.c
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about narrative nonfiction by analyzing the author’s purpose in an autobiography.
	I can use language to make connections between reading and writing.
	I can use elements of narrative nonfiction writing to write a personal narrative.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Map: Weekly Question T18–T19
	Listening Comprehension: Read Aloud “Sally Ride” T20–T21
	Narrative Nonfiction T22–T23
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T23
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T32–T47
»	Preview Vocabulary
»	Read: Reaching for the Moon
	Respond and Analyze T48–T49
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T49
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T24–T25
	Word Study: Teach Suffixes -ed, -ing, 
-s, -er, -est T26–T27
	 READING BRIDGE	
	Word Study: Apply Suffixes -ed, -ing, 
-s, -er, -est T50–T51

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T30–T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T52–T53
	Strategy and Intervention Activities T52
	Fluency T52
	ELL Targeted Support T52
	Conferring T53
INDEPENDENT/COLLABORATIVE
	Independent Reading T53
	Literacy Activities T53
	Collaboration T53

	
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T338–T339
»	Personal Narrative
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T339
	Conferences T336
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T342–T343
»	Know the Narrator
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T343
	Conferences T336

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Suffixes T340
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T340
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Subjects and Predicates T341


	 WRITING BRIDGE	
	Spelling: Teach Words with 
Suffixes T344
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Subjects and Predicates T345


 (
UNIT 
1
 WEEK 1
SUGGESTED WEEKLY PLAN
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
RI.4.1, RI.4.2, RF.4.4.a, W.4.4, SL.4.1, L.4.3
) (
RI.4.8, RI.4.10, RF.4.3, W.4.4, SL.4.1, L.4.1.b
) (
RI.4.8, RI.4.7, RF.4.4, W.4.3, SL.4.1.c, L.4.3
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Explain Author’s Purpose T54–T55
»	Close Read: Reaching for the Moon
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T55
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Use Text Evidence T62–T63
»	Close Read: Reaching for the Moon
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T63
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T70–T71
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T71
»	Weekly Question


	 READING BRIDGE	
	Read Like a Writer: Analyze Author’s 
Use of Graphics T56–T57
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Suffixes 
-ed, -ing, -s, -er, -est T58–T59
	 READING BRIDGE	
	Write for a Reader: Use Graphics in Writing T64–T65
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Suffixes 
-ed, -ing, -s, -er, -est T66–T67
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Suffixes -ed, -ing, -s, 
-er, -est T72–T73
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T73

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T60–T61
	Strategy and Intervention Activities T60
	Fluency T60
	ELL Targeted Support T60
	Conferring T61
INDEPENDENT/COLLABORATIVE
	Independent Reading T61
	Literacy Activities T61
	Partner Reading T61
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T68–T69
	Strategy and Intervention Activities T68
	Fluency T68
	ELL Targeted Support T68
	Conferring T69
INDEPENDENT/COLLABORATIVE
	Independent Reading T69
	Literacy Activities T69

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T74–T75
	Strategy, Intervention, and On-Level/
Advanced Activities T74
	ELL Targeted Support T74
	Conferring T75
INDEPENDENT/COLLABORATIVE
	Independent Reading T75
	Literacy Activities T75
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T75 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T346–T347
»	Know the Setting and Events
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T347
	Conferences T336
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T350–T351
»	Brainstorm and Set a Purpose
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T351
	Conferences T336
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T354
»	Plan Your Personal Narrative
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T355 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T336

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Words with 
Suffixes T348
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Language and Conventions: Teach Subjects and Predicates T349

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review: Suffixes -ed, -ing, 
-s, -er, -est T352
	Language and Conventions: Practice Subjects and Predicates T353


	 WRITING BRIDGE	
	Spelling: Words with Suffixes T356
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T356
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T357





 (
RI.4.10, RI.4.5, RF.4.3.a, W.4.10, SL.4.1, L.4.2.d
) (
RI.4.3, RI.4.1, RF.4.3.a, W.4.3, SL.4.1, L.4.3
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about narrative nonfiction by analyzing how an author supports ideas with details in an autobiography.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of narrative nonfiction writing to write a personal narrative.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T80–T81
	Listening Comprehension: Read Aloud “Defying Gravity” T82–T83
	Biography T84–T85
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T85
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T94–T107
»	Preview Vocabulary
»	Read: Rare Treasure
	Respond and Analyze T108–T109
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T109
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms and Antonyms T86–T87
	Word Study: Teach Suffixes -ity, -ty, 
-ic, -ment T88–T89
	 READING BRIDGE	
	Word Study: Apply Suffixes -ity, -ty, 
-ic, -ment T110–T111

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T92–T93
	Strategy, Intervention, and On-Level/
Advanced Activities T92
	ELL Targeted Support T92
	Conferring T93
INDEPENDENT/COLLABORATIVE
	Independent Reading T93
	Literacy Activities T93
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T93 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T112–T113
	Strategy and Intervention Activities T112
	Fluency T112
	ELL Targeted Support T112
	Conferring T113
INDEPENDENT/COLLABORATIVE
	Independent Reading T113
	Literacy Activities T113
	Partner Reading T113

	
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T362–T363
»	Portray People
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T363
	Conferences T360
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T366–T367
»	Compose a Setting
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T367
	Conferences T360

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Suffixes T364
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T364
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Subjects and Predicates T365


	 WRITING BRIDGE	
	Spelling: Teach Words with Suffixes T368
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Compound Subjects and Predicates T369


 (
UNIT 
1
 WEEK 
2
SUGGESTED WEEKLY PLAN
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
RI.4.8, RI.4.10, RF.4.4, W.4.3.d, SL.4.1, L.4.3
) (
RI.4.1, RI.4.10, RF.4.4.c, W.4.3.d, SL.4.4, L.4.2
) (
RI.4.2, RI.4.3, RF.4.4a, W.4.3, SL.4.1, L.4.3
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Main Idea and Details 
T114–T115
»	Close Read: Rare Treasure
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T115
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Generate Questions T122–T123
»	Close Read: Rare Treasure
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T123
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T130–T131
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T131
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Figurative Language T116–T117
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Suffixes -ity, -ty, -ic, 
-ment T118–T119
	 READING BRIDGE	
	Write for a Reader: Use Figurative Language T124–T125
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: 
Suffixes -ed, -ing, -s, -er, -est 
T126–T127
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Suffixes -ity, -ty, -ic, 
-ment T132–T133
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T133

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T120–T121
	Strategy and Intervention Activities T120
	Fluency T120
	ELL Targeted Support T120
	Conferring T121
INDEPENDENT/COLLABORATIVE
	Independent Reading T121
	Literacy Activities T121
	Partner Reading T121
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T128–T129
	Strategy and Intervention Activities T128
	Fluency T128
	ELL Targeted Support T128
	Conferring T129
INDEPENDENT/COLLABORATIVE
	Independent Reading T129
	Literacy Activities T129
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T134–T135
	Strategy, Intervention, and On-Level/
Advanced Activities T134
	ELL Targeted Support T134
	Conferring T135
INDEPENDENT/COLLABORATIVE
	Independent Reading T135
	Literacy Activities T135
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T135 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T370–T371
»	Develop an Idea with Relevant Details
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T371
	Conferences T360
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T374–T375
»	Use Concrete Words and Phrases
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T375
	Conferences T360
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T378
»	Compose with Sensory Details
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T379 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T360

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Words with 
Suffixes T372
	Language and Conventions: Teach Compound Subjects and Predicates T373

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Suffixes 
-ed, -ing, -s, -er, -est T376
	Language and Conventions: Practice Compound Subjects and Predicates T377

	 WRITING BRIDGE	
	Spelling: Words with Suffixes T380
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T380
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T381






 (
RI.4.1, RI.4.2, RF.4.3, W.4.3, SL.4.1, L.4.4.a
) (
RI.4.3, RI.4.4, RF.4.3, W.4.3.a, SL.4.1, L.4.1.f
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about the theme Networks by analyzing the text structure of a magazine article.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of narrative nonfiction writing to write a personal narrative.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
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»	Use Transition Words and Phrases
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MINILESSON
	Personal Narrative T398–T399
»	Compose Dialogue
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	Personal Narrative T399
	Conferences T384
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T402
»	Develop and Compose a Conclusion
»	Share Back
INDEPENDENT WRITING
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about the theme Networks by analyzing the text structure of an informational text.
	I can use language to make connections between reading and writing.
	I can use elements of narrative nonfiction writing to write a personal narrative.
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	Independent Reading T249
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	Personal Narrative T418–T419
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»	Share Back
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Materials
Turn the page for a list of materials that 
will support planning for the week.
)Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about narrative nonfiction 
by analyzing text structure in a biography.
	I can use language to make connections between reading and writing.
	I can use elements of narrative nonfiction writing to write a personal narrative.
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	Literacy Activities T313
	Partner Reading T313
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	Fluency T320
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	Conferring T321
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	Independent Reading T321
	Literacy Activities T321
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 PROJECT FOCUS 	This week students will
• research historic places in their community.
• create a brochure to argue that a place should be made 
a historic landmark.

	 LESSON 1	
T458–T461RI.4.1, RI.4.3, RI.4.4, RI.4.6, RI.4.10, W.4.1, W.4.7

	Compare Across Texts
•	Answer the Essential Question
	Inquire
•	Introduce Inquiry Project
•	Read “Historic Landmarks”
•	Generate questions
•	Use Academic Vocabulary

	
	
	

	 LESSON 2	
T462–T465RI.4.6, RI.4.10, W.4.1, W.4.1.b, W.4.7, W.4.8

	Explore and Plan
•	Argumentative Writing
•	Read “Save Our Theater”
•	Claims and evidence
	Conduct Research
•	Field research
•	Detailed descriptions

	
	
	

	 LESSON 3	
T466–T469RI.4.6, RI.4.10, W.4.1, W.4.1.a, SL.4.1.a

	Collaborate and Discuss
•	Read a Student Model
•	Identify features of argumentative texts
	Refine Research
•	Primary and secondary sources
•	Read “Ellis Island: Gateway to America”
•	Classify sources in an article

	
	
	

	 LESSON 4	
T470–T473RI.4.7, SL.4.5, W.4.1, W.4.5, W.4.9.b

	Extend Research
•	Incorporate media
•	Brainstorm media for brochure
	Collaborate and Discuss
•	Revise sentence structure
•	Edit for conventions
•	Peer review brochures

	
	
	

	 LESSON 5	
T474–T475SL.4.6, W.4.6, L.4.3.c

	Celebrate and Reflect
•	Share your brochures
•	Reflect on your work
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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UNIT THEME
Adaptations
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	WEEK 3
	

	
	
	Informational Text
	
	Informational Text
	
	Fiction
	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_3.png]

	
	
	Feathers: Not Just 
for Flying

	
	Animal Mimics


	
	from Minn of 
the Mississippi

	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Minilesson 
Bank
	Infographic: Why Animals Adapt
	RI.4.7
	Media: Survival Adaptations
	RI.4.7
	Primary Source: Saving Elephants
	RI.4.10

	
	
	Informational Text: Feathers: Not Just for Flying
	RI.4.10
	Informational Text: Animal Mimics
	RI.4.10
	Fiction: from Minn of the Mississippi
	RL.4.10

	
	
	Domain-Specific Vocabulary
	L.4.6
	Domain-Specific Vocabulary
	L.4.6
	Descriptive Language
	L.4.5

	
	
	Analyze Main Idea and Details
	RI.4.2
	Analyze Text Structure
	RI.4.5
	Analyze Plot and Setting
	RL.4.3

	
	
	Monitor Comprehension
	RI.4.10
	Confirm or Correct Predictions
	RI.4.10
	Use Text Evidence
	RL.4.1

	
	
	Talk About It: Opinion
	SL.4.1
	Write to Sources: Response to Informational Text
	W.4.9.b
	Write to Sources: Response to Literature
	W.4.9

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.4.5
	Synonyms and Antonyms
	L.4.5.c
	Context Clues
	L.4.4.a

	
	
	Word Study
	Plurals
	RF.4.3
	Vowel Diphthongs
	RF.4.3
	Irregular Plurals
	RF.4.3

	
	
	Read Like a Writer
	Analyze Print and Graphic Features
	RI.4.7
	Analyze Print Text Features
	RI.4.10
	Analyze Figurative Language
	L.4.5.a

	
	
	Write for a Reader
	Use Print and Graphic Features
	W.4.2
	Use Print Text Features
	W.4.2
	Use Figurative Language
	W.4.3.d

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Analyze a Travel Article
	W.4.2
	Develop an Introduction
	W.4.2.a
	Compose a Headline
	W.4.2

	
	
	Analyze a Lead Paragraph
	W.4.2
	Develop Relevant Details
	W.4.2.b
	Compose Body Paragraphs
	W.4.2.b

	
	
	Analyze Photographs
	W.4.2
	Develop Different Types of Details
	W.4.2.b
	Group Paragraphs into Sections
	W.4.2.a

	
	
	Brainstorm and Set a Purpose
	W.4.2
	Compose Captions for Visuals
	W.4.2.a
	Develop Transitions
	W.4.2.c

	
	
	Plan Your Travel Article
	W.4.2
	Develop a Conclusion
	W.4.2.e
	Compose with Multimedia
	W.4.2.a

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Plurals
	L.4.2.d
	Spell Vowel Diphthongs
	L.4.2.d
	Spell Words with Irregular Plurals
	L.4.2.d

	
	
	Language and Conventions
	Compound Sentences
	L.4.2.c
	Complex Sentences
	L.4.1
	Common and Proper Nouns
	L.4.1



 (
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2
SKILLS OVERVIEW
)
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 (
Essential Question
)
How do living things adapt to the world around them?
	WEEK 4
	
	WEEK 5
	

	Poetry
	
	Informational Text
	

	from Butterfly Eyes and Other Secrets of the Meadow
	
	The Weird and 
Wonderful Echidna 
and The Very Peculiar Platypus

	
	CCSS
	
	CCSS

	Infographic: Part of a Habitat
	RI.4.7
	Infographic: Many Ways to Be One of a Kind
	RI.4.7

	Poetry: from Butterfly Eyes and Other Secrets of the Meadow
	RL.4.10
	Informational Text: The Weird and Wonderful Echidna and The Very Peculiar Playtpus
	RI.4.10

	Descriptive Language
	L.4.5.c
	Domain-Specific Words
	L.4.6

	Explain Poetic Language and Elements
	RI.4.5
	Synthesize Information
	RI.4.9

	Visualize Imagery
	RL.4.10
	Monitor Comprehension
	RI.4.10

	Write to Sources: Opinion
	W.4.1
	Talk About It
	RI.4.9

	Analogies
	L.4.5
	Parts of Speech
	L.4.1

	Greek Roots
	RF.4.3.a
	Latin Roots terr, rupt, tract, aqua, dict
	RF.4.3.a

	Analyze Imagery
	RL.4.4
	Analyze Text Structure
	RI.4.5

	Use Imagery
	W.4.3
	Use Text Structure
	W.4.9.b

	Writer’s Craft
	Publish, Celebrate, and Assess

	Use Linking Words and Phrases
	W.4.2.c
	Edit Complete Sentences
	L.4.1.f

	Use Precise Language and Vocabulary
	W.4.2.d
	Edit for Nouns
	W.4.5

	Edit for Capitalization
	L.4.2.a
	Publish and Celebrate
	W.4.2

	Edit for Adverbs
	L.4.1
	Prepare for Assessment
	W.4.2

	Edit for Coordinating Conjunctions
	L.4.1
	Assessment
	W.4.2

	Spell Words with Greek Roots
	L.4.2.d
	Spell Words with Latin Roots
	L.4.2.d

	Singular and Plural Nouns
	L.4.1
	Subject-Verb Agreement
	L.4.1
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	Saving Species


	

	
	CCSS

	Leveled Research Articles
	RI.4.10

	Use Academic Words
	L.4.6

	Explore and Plan: Informational Text
	W.4.7

	Conduct Research: Library Database
	W.4.8

	Informational Text: Informational Poster
	RI.4.10

	Refine Research: Develop 
a Bibliography
	W.4.8

	Extend Research: Incorporate Media
	SL.4.5

	Revise for Clarity
	W.4.5

	Edit and Peer Review
	W.4.5

	Celebrate and Reflect
	SL.4.4





 (
RF.4.4.a, RI.4.10, SL.4.1, L.4.4, W.4.2
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about historical fiction and analyze plot and setting in historical fiction.
	I can develop knowledge about language to make connections between reading fiction and writing historical fiction.
	I can use elements of narrative text to write 
a historical fiction story.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 (
RI.4.4, SL.4.2, L.4.5,
 
L.4.6, W.4.2
) LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic
	Weekly Question T18–T19
	Listening Comprehension: Read Aloud “Snowy Owls” T20–T21
	Informational Text T22–T23
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T23
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T32–T51
»	Preview Vocabulary
»	Read: Feathers: Not Just for Flying
	Respond and Analyze T52–T53
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T53
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T24–T25
	Word Study: Teach Plurals T26–T27
	 READING BRIDGE	
	Word Study: Apply Plurals T54–T55

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T30–T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T56–T57
	Strategy and Intervention Activities T56
	Fluency T56
	ELL Targeted Support T56
	Conferring T57
INDEPENDENT/COLLABORATIVE
	Independent Reading T57
	Literacy Activities T57
	Collaboration T57

	
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T340–T341
»	Analyze a Travel Article
»	Share Back
INDEPENDENT WRITING
	Travel Article T341
	Conferences T338
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T344–T345
»	Analyze a Lead Paragraph
»	Share Back
INDEPENDENT WRITING
	Travel Article T345
	Conferences T338

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Plurals T342
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T342
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Fix Sentence Fragments T343


	 WRITING BRIDGE	
	Spelling: Teach Spell Plurals T346
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Compound Sentences T347
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 (
RF.4.3, SL.4.1,
 
L.4.2.d, W.4.5
) (
RI.4.10, SL.4.1.c,
 
L.4.2.c, W.4.2
) (
RI.4.2, RI.4.7, SL.4.3, L.4.2.d, L.4.2.c, W.4.2
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Main Idea and Details T58–T59
»	Close Read: Feathers: Not Just for Flying
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T59
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Monitor Comprehension T66–T67
»	Close Read: Feathers: Not Just for Flying
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T67
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T74–T75
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T75
»	Weekly Question


	 READING BRIDGE	
	Read Like a Writer: Analyze Print and Graphic Features T60–T61
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Plurals 
T62–T63
	 READING BRIDGE	
	Write for a Reader: Use Print and Graphic Features T68–T69
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Prefixes 
mis-, en-, em- T70–T71
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Plurals T76–T77
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T76

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T64–T65
	Strategy and Intervention Activities T64
	Fluency T64
	ELL Targeted Support T64
	Conferring T65
INDEPENDENT/COLLABORATIVE
	Independent Reading T65
	Literacy Activities T65
	Partner Reading T65
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T72–T73
	Strategy and Intervention Activities T72
	Fluency T72
	ELL Targeted Support T72
	Conferring T73
INDEPENDENT/COLLABORATIVE
	Independent Reading T73
	Literacy Activities T73

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T78–T79
	Strategy, Intervention, and On-Level/
Advanced Activities T78
	ELL Targeted Support T78
	Conferring T79
INDEPENDENT/COLLABORATIVE
	Independent Reading T79
	Literacy Activities T79
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T79 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Travel Article T348–T349
»	Analyze Photographs
»	Share Back
INDEPENDENT WRITING
	Travel Article T349
	Conferences T338
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T352–T353
»	Brainstorm and Set a Purpose
»	Share Back
INDEPENDENT WRITING
	Travel Article T353
	Conferences T338
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T356
»	Plan Your Travel Article
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T356–T357 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T338

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Spell 
Plurals 350
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Language and Conventions: Teach Compound Sentences T351

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Prefixes 
mis-, en-, em- T354
	Language and Conventions: Practice Compound Sentences T355


	 WRITING BRIDGE	
	Spelling: Spell Plurals T358
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T358
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T359






 (
RI.4.10, SL.4.1.c, L.4.4, W.4.2.b
) (
RI.4.7, SL.4.1.c, L.4.4,
 
L.4.4.c, L.4.5.c, W.4.2
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn about informational text by analyzing cause-and-effect text structure.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of informational text to write an article.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Media
	Weekly Question T84–T85
	Listening Comprehension: Read Aloud “Moths in Hiding” T86–T87
	Informational Text T88–T89
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T89
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T98–T119
»	Preview Vocabulary
»	Read: Animal Mimics
	Respond and Analyze T120–T121
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T121
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms and Antonyms T90–T91
	Word Study: Teach Vowel Diphthongs T92–T93
	 READING BRIDGE	
	Word Study Apply Vowel Diphthongs T122–T123
	High-Frequency Words T123

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T96–T97
	Strategy, Intervention, and On-Level/
Advanced Activities T96
	ELL Targeted Support T96
	Conferring T97
INDEPENDENT/COLLABORATIVE
	Independent Reading T97
	Literacy Activities T97
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T97 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T124–T125
	Strategy and Intervention Activities T124
	Fluency T124
	ELL Targeted Support T124
	Conferring T125
INDEPENDENT/COLLABORATIVE
	Independent Reading T125
	Literacy Activities T125
	Partner Reading T125

	
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T364–365
»	Develop an Introduction
»	Share Back
INDEPENDENT WRITING
	Travel Article T365
	Conferences T362
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T368–T369
»	Develop Relevant Details
»	Share Back
INDEPENDENT WRITING
	Travel Article T369
	Conferences T362

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Vowel Diphthongs T366
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T366
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Compound Sentences T367


	 WRITING BRIDGE	
	Spelling: Teach Spell Vowel Diphthongs T370
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Complex Sentences T371
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 (
RF.4.3, SL.4.1.c, L.4.2.d, W.4.2.e, W.4.9.b
) (
RI.4.10, SL.4.1, L.4.1, W.4.2.a
) (
RI.4.5, SL.4.1, L.4.1, L.4.2.d, W.4.2.b
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Text Structure T126–T127
»	Close Read: Animal Mimics
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T127
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Confirm or Correct Predictions 
T134–T135
»	Close Read: Animal Mimics
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T135
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T142–T143
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T143
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Print Text Features T128–T129
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Vowel Diphthongs T130–T131
	 READING BRIDGE	
	Write for a Reader: Use Print Text Features T136–T137
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Plurals 
T138–T139
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Vowel Diphthongs 
T144–T145
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T144

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T132–T133
	Strategy and Intervention Activities T132
	Fluency T132
	ELL Targeted Support T132
	Conferring T133
INDEPENDENT/COLLABORATIVE
	Independent Reading T133
	Literacy Activities T133
	Partner Reading T133
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T140–T141
	Strategy and Intervention Activities T140
	Fluency T140
	ELL Targeted Support T140
	Conferring T141
INDEPENDENT/COLLABORATIVE
	Independent Reading T141
	Literacy Activities T141
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T146–T147
	Strategy, Intervention, and On-Level/
Advanced Activities T146
	ELL Targeted Support T146
	Conferring T147
INDEPENDENT/COLLABORATIVE
	Independent Reading T147
	Literacy Activities T147
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T147 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Travel Article T372–T373
»	Develop Different Types of Details
»	Share Back
INDEPENDENT WRITING
	Travel Article T373
	Conferences T362
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T376–T377
»	Compose Captions for Visuals
»	Share Back
INDEPENDENT WRITING
	Travel Article T377
	Conferences T362
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T380
»	Develop a Conclusion
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T380–T381 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T362

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Spell Vowel Diphthongs T374
	Language and Conventions: Teach Complex Sentences T375

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Spell 
Plurals T378
	Language and Conventions: Practice Complex Sentences T379

	 WRITING BRIDGE	
	Spelling: Spell Vowel Diphthongs T382
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 (
RL.4.10, RF.4.4.b, SL.4.6, L.4.1, L.4.2.d, W.4.2, W.4.2.a
) (
RF.4.4.b, SL.4.1.c, L.4.2.d, L.4.4.a,
 
W.4.2.a
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn about fiction by analyzing the significance of plot and setting.
	I can develop knowledge about language 
to make connections between reading and writing.
	I can use elements of informational text 
to write an article.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Primary Source: Weekly Question T152–T153
	Listening Comprehension: Read Aloud “Encounter” T154–T155
	Fiction T156–T157
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T157
	 LESSON 2 
 READING WORKSHOP	
GENRE & THEME
	Introduce the Text T166–T177
»	Preview Vocabulary
»	Read: from Minn of the Mississippi
	Respond and Analyze T178–T179
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T179
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues T158–T159
	Word Study: Teach Irregular Plurals T160–T161
	 READING BRIDGE	
	Word Study: Apply Irregular Plurals 
T180–T181

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T164–T165
	Strategy, Intervention, and On-Level/
Advanced Activities T164
	ELL Targeted Support T164
	Conferring T165
INDEPENDENT/COLLABORATIVE
	Independent Reading T165
	Literacy Activities T165
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T165 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T182–T183
	Strategy and Intervention Activities T182
	Fluency T182
	ELL Targeted Support T182
	Conferring T183
INDEPENDENT/COLLABORATIVE
	Independent Reading T183
	Literacy Activities T183
	Collaboration T183

	
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T388–T389
»	Compose a Headline
»	Share Back
INDEPENDENT WRITING
	Travel Article T389
	Conferences T386
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T392–T393
»	Compose Body Paragraphs
»	Share Back
INDEPENDENT WRITING
	Travel Article T393
	Conferences T386

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Words with Irregular 
Plurals T390
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T390
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Complex Sentences T391

	 WRITING BRIDGE	
	Spelling: Teach Spell Words with Irregular Plurals T394
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Common and Proper 
Nouns T395
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RF.4.3, SL.4.1, L.4.2.d, W.4.2.a, W.4.9.a
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RL.4.1, SL.4.1, L.4.1, W.4.2.c
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RL.4.3, RL.4.10, SL.4.1, L.4.5.a, W.4.2.a
)
	 LESSON 3 
 READING WORKSHOP	
GENRE & THEM
	Analyze Plot and Setting T184–T185
»	Close Read: from Minn of the Mississippi
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T185
	 LESSON 4 
 READING WORKSHOP	
GENRE & THEM
	Use Text Evidence T192–T193
»	Close Read: from Minn of the Mississippi
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T193
	 LESSON 5 
 READING WORKSHOP	
GENRE & THEM
	Reflect and Share T200–T201
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T201
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Figurative Language T186–T187
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Irregular 
Plurals T188–T189
	 READING BRIDGE	
	Write for a Reader: Use Figurative Language T194–T195
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Vowel Diphthongs T196–T197
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Irregular Plurals 
T202–T203
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T202

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T190–T191
	Strategy and Intervention Activities T190
	Fluency T190
	ELL Targeted Support T190
	Conferring T191
INDEPENDENT/COLLABORATIVE
	Independent Reading T191
	Literacy Activities T191
	Partner Reading T191
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T198–T199
	Strategy and Intervention Activities T198
	Fluency T198
	ELL Targeted Support T198
	Conferring T199
INDEPENDENT/COLLABORATIVE
	Independent Reading T199
	Literacy Activities T199
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T204–T205
	Strategy, Intervention, and On-Level/
Advanced Activities T204
	ELL Targeted Support T204
	Conferring T205
INDEPENDENT/COLLABORATIVE
	Independent Reading T205
	Literacy Activities T205
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T205 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Travel Article T396–T397
»	Group Paragraphs into Sections
»	Share Back
INDEPENDENT WRITING
	Travel Article T397
	Conferences T386
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T400–T401
»	Develop Transitions
»	Share Back
INDEPENDENT WRITING
	Travel Article T401
	Conferences T386
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T404
»	Compose with Multimedia
»	Share Back
INDEPENDENT WRITING
	Select a Genre T405
	Conferences T386

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Spell Words 
with Irregular Plurals T398
	Language and Conventions: Teach Common and Proper Nouns T399

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Spell Vowel Diphthongs T402
	Language and Conventions: Practice Common and Proper Nouns T403

	 WRITING BRIDGE	
	Spelling: Spell Words with Irregular 
Plurals T406
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T406
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T407






 (
RL.4.10, SL.4.1, L.4.1, L.4.3.a, W.4.2.d
) (
RF.4.4.a, SL.4.1.c, L.4.1, L.4.3.a, L.4.5, W.4.2.c
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about poetry and read a text that helps me analyze structure, rhythm, rhyme, and meter.
	I can develop knowledge about language to make connections between reading poetry and writing poetry.
	I can use elements of informational text 
to write a travel article.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T210–T211
	Listening Comprehension: Read Aloud “Chameleon” T212–T213
	Poetry T214–T215
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T215
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T224–T237
»	Preview Vocabulary
»	Read: Butterfly Eyes and Other Secrets of the Meadow
	Respond and Analyze T238–T239
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T239
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Analyze Analogies T216–T217
	Word Study: Teach Greek Roots 
T218–T219
	 READING BRIDGE	
	Word Study: Apply Greek Roots 
T240–T241

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T222–T223
	Strategy, Intervention, and On-Level/
Advanced Activities T222
	ELL Targeted Support T222
	Conferring T223
INDEPENDENT/COLLABORATIVE
	Independent Reading T223
	Literacy Activities T223
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T223 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T242–T243
	Strategy and Intervention Activities T242
	Fluency T242
	ELL Targeted Support T242
	Conferring T243
INDEPENDENT/COLLABORATIVE
	Independent Reading T243
	Literacy Activities T243
	Partner Reading T243

	
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T412–T413
»	Use Linking Words and Phrases
»	Share Back
INDEPENDENT WRITING
	Travel Article T413
	Conferences T410
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T416–T417
»	Use Precise Language and Vocabulary
»	Share Back
INDEPENDENT WRITING
	Travel Article T417
	Conferences T410

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Words with Greek 
Roots T414
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T414
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Common and Proper 
Nouns T415
	 WRITING BRIDGE	
	Spelling: Teach Spell Words with Greek Roots T418
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Singular and Plural 
Nouns T419
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Explain Poetic Language and Elements T244–T245
»	Close Read: Butterfly Eyes and Other Secrets of the Meadow
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T245
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Visualize Imagery T252–T253
»	Close Read: Butterfly Eyes and Other Secrets of the Meadow
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T253
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T260–T261
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T261
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Imagery 
T246–T247
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Greek 
Roots T248–T249
	 READING BRIDGE	
	Write for a Reader: Use Imagery 
T254–T255
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Irregular 
Plurals T256–T257
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Greek Roots T262–T263
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T262

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T250–T251
	Strategy and Intervention Activities T250
	Fluency T250
	ELL Targeted Support T250
	Conferring T251
INDEPENDENT/COLLABORATIVE
	Independent Reading T251
	Literacy Activities T251
	Partner Reading T251
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T258–T259
	Strategy and Intervention Activities T258
	Fluency T258
	ELL Targeted Support T258
	Conferring T259
INDEPENDENT/COLLABORATIVE
	Independent Reading T259
	Literacy Activities T259
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T264–T265
	Strategy, Intervention, and On-Level/
Advanced Activities T264
	ELL Targeted Support T264
	Conferring T265
INDEPENDENT/COLLABORATIVE
	Independent Reading T265
	Literacy Activities T265
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T265 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Travel Article T420–T421
»	Edit for Capitalization
»	Share Back
INDEPENDENT WRITING
	Travel Article T421
	Conferences T410
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T424–T425
»	Edit for Adverbs
»	Share Back
INDEPENDENT WRITING
	Travel Article T425
	Conferences T410
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T428
»	Edit for Coordinating Conjunctions
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T428–T429 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T410

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Spell Words 
with Greek Roots T422
	Language and Conventions: Teach Singular and Plural Nouns T423

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Spell Words 
with Irregular Plurals T426
	Language and Conventions: Practice Singular and Plural Nouns T427

	 WRITING BRIDGE	
	Spelling: Spell Words with Greek 
Roots T430
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T430
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T431






 (
RF.4.4.a, RI.4.4, SL.4.1, L.4.2, L.4.2.a, L.4.4, L.4.6, W.4.5
) (
RI.4.10, SL.4.1.c, L.4.1, L.4.1.f, W.4.5
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational text by integrating information from multiple sources.
	I can develop knowledge about language 
to make connections between reading and writing.
	I can use elements of informational text 
to write an article.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Writing Workshop Assessment
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
	Writing Workshop Performance-Based Assessment
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T270–T271
	Listening Comprehension: Read Aloud “Primates of Madagascar” T272–T273
	Informational Text T274–T275
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T275
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Texts T284–T301
»	Preview Vocabulary
»	Read and Compare Texts
	Respond and Analyze T302–T303
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T303
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Parts of Speech T276–T277
	Word Study: Teach Latin Roots terr, rupt, tract, aqua, dict T278–T279
	 READING BRIDGE	
	Word Study Apply Latin Roots terr, rupt, tract, aqua, dict T304–T305

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T282–T283
	Strategy, Intervention, and On-Level/
Advanced Activities T282
	ELL Targeted Support T282
	Conferring T283
INDEPENDENT/COLLABORATIVE
	Independent Reading T283
	Literacy Activities T283
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T283 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T306–T307
	Strategy and Intervention Activities T306
	Fluency T306
	ELL Targeted Support T306
	Conferring T309
INDEPENDENT/COLLABORATIVE
	Independent Reading T309
	Literacy Activities T309


	
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T436–T437
»	Edit Complete Sentences
»	Share Back	
INDEPENDENT WRITING
	Travel Article T437
	Conferences T434
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T440–T441
»	Edit for Nouns
»	Share Back	
INDEPENDENT WRITING
	Travel Article T441
	Conferences T434

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Words with Latin 
Roots T438
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T438
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Singular and Plural Nouns T439

	 WRITING BRIDGE	
	Spelling: Teach: Spell Words with Latin Roots T442
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Subject-Verb Agreement T443
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Synthesize Information T308–T309
»	Close Read and Compare: The Weird and Wonderful Echidna and The Very Peculiar Platypus
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T309
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Monitor Comprehension T316–T317
»	Close Read and Compare: The Weird and Wonderful Echidna and The Very Peculiar Platypus
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T317
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T324–T325
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T325
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Text 
Structure T310–T311
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Latin Roots 
terr, rupt, tract, aqua, dict T312–T313
	 READING BRIDGE	
	Write for a Reader: Use Text Structure T318–T319
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Greek 
Roots T320–T321
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Latin Roots terr, rupt, 
tract, aqua, dict T326–T327
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T326

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T314–T315
	Strategy and Intervention Activities T314
	Fluency T314
	ELL Targeted Support T314
	Conferring T315
INDEPENDENT/COLLABORATIVE
	Independent Reading T315
	Literacy Activities T315
	Partner Reading T315
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T322–T323
	Strategy and Intervention Activities T322
	Fluency T322
	ELL Targeted Support T322
	Conferring T323
INDEPENDENT/COLLABORATIVE
	Independent Reading T323
	Literacy Activities T323
	Partner Reading T323
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T328–T329
	Strategy, Intervention, and On-Level/
Advanced Activities T328
	ELL Targeted Support T328
	Conferring T329
INDEPENDENT/COLLABORATIVE
	Independent Reading T329
	Literacy Activities T329
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T329 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Travel Article T444–T445
»	Publish and Celebrate
»	Share Back
INDEPENDENT WRITING
	Travel Article T445
	Conferences T434
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T448–T449
»	Prepare for Assessment
»	Share Back
INDEPENDENT WRITING
	Travel Article T449
	Conferences T434
	 WRITING WORKSHOP	
MINILESSON
	Travel Article T452–T453
»	Assessment
»	Share Back
INDEPENDENT WRITING
	Assessment T452–T453
	Conferences T434

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Spell Words 
with Latin Roots T446
	Language and Conventions: Teach 
Subject-Verb Agreement T447

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Spell Words 
with Greek Roots T450
	Language and Conventions: Practice Subject-Verb Agreement T451

	 WRITING BRIDGE	
	Spelling: Spell Words with Latin 
Roots T454
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T454
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T455






 PROJECT FOCUS 	This week students will
• research animals and their adaptations.
• create an informational poster about an endangered animal.

	 LESSON 1	
T460–T461
T462–T463RI.4.10, SL.4.1.c, L.4.6, W.4.7

	Compare Across Texts
•	Answer the Essential Question
	Inquire
•	Introduce the Project
•	Read “Adapting to Urban Habitats”
•	Generate questions
•	Use Academic Words

	
	
	

	 LESSON 2	
T464–T465
T466–T467RI.4.10, W.4.7, W.4.8, W.4.9

	Explore and Plan
•	Informational Writing
•	Read “An Unlikely Friendship”
•	Plan your research
	Conduct Research
•	Library Databases
•	Carry out an advanced search

	
	
	

	 LESSON 3	
T468–T469
T470–T471RI.4.10, SL.4.5, W.4.8, W.4.10

	Collaborate and Discuss
•	Analyze Student Model
•	Identify features of informational texts
•	Write first draft
	Refine Research
•	Develop a Bibliography
•	Read “Biomimicry: Shaping the  Shinkansen”

	
	
	

	 LESSON 4	
T472–T473
T474–T475
	Extend Research
•	Incorporate Media
•	Add maps, photos, and other media into poster
	Collaborate and Discuss
•	Revise and Edit: Language
•	Peer Review

	SL.4.5, W.4.5

	
	

	 LESSON 5	
T476–T477SL.4.4, SL.4.5

	Celebrate and Reflect
•	Share posters
•	Reflect on your project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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UNIT THEME
Diversity
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	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_2.png]WEEK 2
	
	WEEK 3
	

	
	
	Realistic Fiction
	
	Realistic Fiction
	
	Autobiography
	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_3.png]

	
	
	from Out of My Mind

	
	from Mama's Window

	
	Trombone Shorty

	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Minilesson 
Bank
	Infographic: Diverse Ways We Communicate
	RI.4.7
	Poem: Meals
	RL.4.10
	Media: Making Music Together
	RI.4.7

	
	
	Realistic Fiction: Out of My Mind
	RL.4.10
	Realistic Fiction: Mama’s Window
	RL.4.10
	Autobiography: Trombone Shorty
	RI.4.10

	
	
	Words that Convey Information About Characters
	L.4.6
	Words that Focus on Plot
	L.4.6
	Words that Connect People and Music
	L.4.6

	
	
	Analyze Characters
	RL.4.3
	Analyze Plot and Setting
	RL.4.3
	Explain Author’s Purpose
	RI.4.10

	
	
	Make Inferences About Characters
	RL.4.1
	Confirm and Correct Predictions
	RL.4.10
	Make Connections
	RI.4.10

	
	
	Talk About It: Opinion
	SL.4.1
	Write to Sources: Response to Literature
	W.4.9.a
	Write to Sources: Opinion
	W.4.1.a

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.4.6
	Synonyms and Antonyms
	L.4.5.c
	Context Clues
	L.4.4.a

	
	
	Word Study
	Related Words
	RF.4.3
	r-Controlled Vowels
	RF.4.3.a
	Final Stable Syllables
	RF.4.3.a

	
	
	Read Like a Writer
	Analyze Repetition
	RL.4.10
	Analyze Adages and Proverbs
	L.4.5.b
	Analyze Graphic Features (Illustrations)
	RI.4.7

	
	
	Write for a Reader
	Use Repetition
	W.4.9
	Use Adages and Proverbs
	W.4.3.b
	Use Graphic Features
	W.4.3

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Understand Realistic Fiction
	W.4.3
	Compose a Character Description: External
	W.4.3.a
	Compose from a Point of View
	W.4.3.a

	
	
	Identify Parts of the Plot
	W.4.4
	Compose a Character Description: Internal
	W.4.3.a
	Compose an Event Sequence
	W.4.3.c

	
	
	Recognize Elements of Realistic Fiction
	W.4.4
	Compose Information About the Setting
	W.4.3.b
	Compose Dialogue
	W.4.3.b

	
	
	Brainstorm a Topic
	W.4.5
	Compose a Plot: Develop a Problem
	W.4.3.a
	Plan Illustrations
	W.4.5

	
	
	Plan Your Realistic Fiction Story
	W.4.5
	Compose a Plot: Develop a Resolution
	W.4.3.e
	Select a Genre
	W.4.4

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Related Words
	L.4.2.d
	Spell Words with 
r-Controlled Vowels
	L.4.2.d
	Spell Words with Final Stable Syllables
	L.4.2.d

	
	
	Language and Conventions
	Prepositions and Prepositional Phrases
	L.4.1.e
	Subject-Verb Agreement
	L.4.1
	Irregular Verbs
	L.4.1



 (
UNIT 
3
 
SKILLS OVERVIEW
)
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 (
Essential Question
)
How can we reach new understandings through exploring diversity?
	WEEK 4
	
	WEEK 5
	

	Fiction
	
	Poetry
	

	Weslandia and 
“The Circuit”
	
	Poetry Collection

	

	
	CCSS
	
	CCSS

	Infographic: New Places Affect How We Eat
	RI.4.7
	Infographic: Approaches to Poetry
	RI.4.7

	Fiction: Weslandia and “The Circuit”
	RL.4.10
	Poetry: Poetry Collection
	RL.4.10

	Words that Convey Point of View
	L.4.6
	Words that Convey Emotions
	L.4.5

	Compare and Contrast Point of View
	RL.4.6
	Examine Poetic Elements
	RL.4.2

	Generate Questions
	RL.4.10
	Visualize to Understand
	RL.4.10

	Write to Sources: Response to Literature
	W.4.1
	Talk About It: Opinion
	SL.4.1

	Figurative Language
	L.4.5.a
	Parts of Speech
	L.4.6

	Syllable Patterns V/CV and VC/V
	RF.4.3.a
	Silent Letters
	RF.4.3.a

	Analyze Purpose and Message
	W.4.5
	Analyze Literary Devices
	RL.4.10

	Use Purpose and Message
	W.4.3
	Use Literary Devices
	W.4.4

	Writer’s Craft
	Publish, Celebrate, and Assess

	Use Irregular Verbs
	L.4.1
	Rearrange and Combine Ideas
	W.4.5

	Edit for Punctuation
	L.4.2.c
	Edit for Capitalization 
	L.4.2.a

	Edit for Prepositional Phrases
	L.4.1.e
	Publish and Celebrate 
	W.4.3

	Edit for Coordinating Conjunctions
	W.4.5
	Prepare for Assessment 
	W.4.3

	Use Pronouns
	L.4.1.a
	Assessment 
	W.4.3

	Spell V/CV and VC/V Words
	L.4.2.d
	Spell Words with Silent Letters
	L.4.2.d

	Progressive Verb Tenses
	L.4.1.b
	Auxiliary Verbs 
	L.4.1.c
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	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_5.png]Inquiry and Research
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	Let’s All Play!

	

	
	CCSS

	Leveled Research Articles
	RI.4.10

	Use Academic Words
	L.4.6

	Explore and Plan: Argumentative Writing
	W.4.7

	Conduct Research: Search Engines
	W.4.8

	Argumentative Writing: Letter to the Principal
	W.4.1

	Refine Research: Paraphrasing and Quoting
	W.4.8

	Extend Research: Incoporate Media
	W.4.7

	Revise Word Choice
	W.4.5

	Edit and Peer Review
	W.4.5

	Celebrate and Reflect
	SL.4.4





 (
RL.4.1, RL.4.10, RF.4.4.a, W.4.3, L.4.1.e, L.4.6
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about fiction by analyzing characters in realistic fiction.
	I can develop knowledge about language 
to make connections between reading and writing.
	I can use elements of narrative text to write a realistic fiction story.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 (
RL.4.10, RF.4.4.b, W.4.8, L.4.4.c, L.4.5
) LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T18–T19
	Listening Comprehension: Read Aloud “Just Lunch” T20–T21
	Realistic Fiction T22–T23
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T23 
	 LESSON 2  
 READING WORKSHOP	
SHARED READ
	Introduce the Text T32–T39
»	Preview Vocabulary
»	Read: Out of My Mind
	Respond and Analyze T40–T41
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T41
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T24–T25
	Word Study: Teach Related Words 
T26–T27
	 READING BRIDGE	
	Word Study: Apply Related Words 
T42–T43

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T30–T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T44–T45
	Strategy and Intervention Activities T44
	Fluency T44
	ELL Targeted Support T44
	Conferring T45
INDEPENDENT/COLLABORATIVE
	Independent Reading T45
	Literacy Activities T45
	Collaboration T45

	
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T332–T333
»	Understand Realistic Fiction
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T333
	Conferences T330
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T336–T337
»	Identify Parts of the Plot
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T337
	Conferences T330

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Related Words T334
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T334
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Subject-Verb Agreement T335


	 WRITING BRIDGE	
	Spelling: Teach Related Words T338
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Prepositions and Prepositional Phrases T339
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 (
RL.4.3, RL.4.10, RF.4.4.b, W.4.3, SL.4.1.a, L.4.1.e
) (
RL.4.7, W.4.1.b, W.4.5, SL.4.1.c, SL.4.3, L.4.1.e
) (
RL.4.1, RF.4.3.a, W.4.3, SL.4.1.b, L.4.1.e
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Characters T46–T47
»	Close Read: Out of My Mind
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T47
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Make Inferences T54–T55
»	Close Read: Out of My Mind
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T55
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T62–T63
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T63
»	Weekly Question


	 READING BRIDGE	
	Read Like a Writer: Analyze Repetition 
T48–T49
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Related 
Words T50–T51
	 READING BRIDGE	
	Write for a Reader: Use Repetition 
T56–T57
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Latin Roots T58–T59
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Related Words T64–T65
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T64

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T52–T53
	Strategy and Intervention Activities T52
	Fluency T52
	ELL Targeted Support T52
	Conferring T53
INDEPENDENT/COLLABORATIVE
	Independent Reading T53
	Literacy Activities T53
	Partner Reading T53
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T60–T61
	Strategy and Intervention Activities T60
	Fluency T60
	ELL Targeted Support T60
	Conferring T61
INDEPENDENT/COLLABORATIVE
	Independent Reading T61
	Literacy Activities T61

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T66–T67
	Strategy, Intervention, and On-Level/
Advanced Activities T66
	ELL Targeted Support T66
	Conferring T67
INDEPENDENT/COLLABORATIVE
	Independent Reading T67
	Literacy Activities T67
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T67 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T340–T341
»	Recognize Elements of Realistic Fiction
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T341
	Conferences T330
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T344–T345
»	Brainstorm a Topic
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T345
	Conferences T330
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T348
»	Plan Your Realistic Fiction Story
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T349 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T330

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Related Words T342
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Language and Conventions: Teach Prepositions and Prepositional Phrases T343
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Latin 
Roots T346
	Language and Conventions: Practice Prepositions and Prepositional Phrases T347


	 WRITING BRIDGE	
	Spelling: Related Words T350
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T350
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T351
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about fiction and read a text that helps me analyze plot and setting.
	I can develop knowledge about language to make connections between reading fiction and writing.
	I can use elements of narrative writing to write a realistic fiction story.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 (
RL.4.2, W.4.3, W.4.3.b, SL.4.1.a, L.4.4.c, L.4.5.c
) LESSON 1   
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Poem: Weekly Question T72–T73
	Listening Comprehension: Read Aloud “The Race” T74–T75
	Genre T76–T77
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T77
	 (
RL.4.10, RF.4.3, W.4.3.a, W.4.3.b, SL.4.1.a, L.4.1
) LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T86–T99
»	Preview Vocabulary
»	Read: Mama’s Window
	Respond and Analyze T100–T101
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T101
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms and Antonyms T78–T79
	Word Study: Teach r-Controlled Vowels T80–T81
	 READING BRIDGE	
	Word Study: Apply r-Controlled Vowels T102–T103

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers
T84–T85
	Strategy, Intervention, and On-Level/
Advanced Activities T84
	ELL Targeted Support T84
	Conferring T85
INDEPENDENT/COLLABORATIVE
	Independent Reading T85
	Literacy Activities T85
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T85 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T104–T105
	Strategy and Intervention Activities T104
	Fluency T104
	ELL Targeted Support T104
	Conferring T105
INDEPENDENT/COLLABORATIVE
	Independent Reading T105
	Literacy Activities T105
	Partner Reading T105

	
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T356–T357
»	Compose a Character Description: External
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T357
	Conferences T354
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T360–T361
»	Compose a Character Description: Internal
»	Share Back
INDEPENDENT WRITING
	Travel Article T361
	Conferences T354

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: r-Controlled Vowels T358
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T358
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Prepositions and Prepositional Phrases T359

	 WRITING BRIDGE	
	Spelling: Teach r-Controlled Vowels T362
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Subject-Verb Agreement T363


 (
UNIT 
3
 WEEK 
2
SUGGESTED WEEKLY PLAN
)

 (
RL.4.3, W.4.2.c, W.4.3.e, SL.4.1.d, L.4.1
) (
RF.4.4.a, W.4.3, W.4.3.a, SL.4.1.d, L.4.1, L.4.5.b
) (
RL.4.3, RL.4.10, W.4.3.b, W.4.3.d, SL.4.1.b, L.4.4.c
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Plot and Setting T106–T107
»	Close Read: Mama’s Window
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T107
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Confirm and Correct Predictions T114–T115
»	Close Read: Mama’s Window
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T115
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T122–T123
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T123
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Mood and Tone 
T108–T109
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: r-Controlled Vowels T110–T111
	 READING BRIDGE	
	Write for a Reader: Mood and Tone 
T116–T117
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Related 
Words T118–T119
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: r-Controlled Vowels 
T124–T125
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T125

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T112–T113
	Strategy and Intervention Activities T112
	Fluency T112
	ELL Targeted Support T112
	Conferring T113
INDEPENDENT/COLLABORATIVE
	Independent Reading T113
	Literacy Activities T113
	Partner Reading T113
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T120–T121
	Strategy and Intervention Activities T120
	Fluency T120
	ELL Targeted Support T120
	Conferring T121
INDEPENDENT/COLLABORATIVE
	Independent Reading T121
	Literacy Activities T121
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T126–T127
	Strategy, Intervention, and On-Level/
Advanced Activities T126
	ELL Targeted Support T126
	Conferring T127
INDEPENDENT/COLLABORATIVE
	Independent Reading T127
	Literacy Activities T127
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T127 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T364–T365
»	Compose Information About the Setting
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T365
	Conferences T354
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T368–T369
»	Compose a Plot: Develop a Problem
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T369
	Conferences T354
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T372
»	Compose a Plot: Develop a Resolution
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T373 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T354

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: r-Controlled 
Vowels T366
	Language and Conventions: Teach 
Subject-Verb Agreement T367

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Related 
Words T370
	Language and Conventions: Practice Subject-Verb Agreement T371

	 WRITING BRIDGE	
	Spelling: r-Controlled Vowels T374
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about the theme Diversity 
by analyzing author’s purpose in an autobiography.
	I can develop knowledge about language 
to make connections between reading and writing.
	I can use elements of narrative writing to write a realistic fiction story.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Media: Weekly Question T132–T133
	Listening Comprehension: Read Aloud “Garage Girl” T134–T135
	Autobiography T136–T137
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T137
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T146–T165
»	Preview Vocabulary
»	Read: Trombone Shorty
	Respond and Analyze T166–T167
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T167
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary Context Clues T138–T139
	Word Study: Final Stable Syllables 
T140–T141
	 READING BRIDGE	
	Word Study Final Stable Syllables 
T168–T169

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T144–T145
	Strategy, Intervention, and On-Level/
Advanced Activities T144
	ELL Targeted Support T144
	Conferring T145
INDEPENDENT/COLLABORATIVE
	Independent Reading T145
	Literacy Activities T145
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T145 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T170–T171
	Strategy and Intervention Activities T170
	Fluency T170
	ELL Targeted Support T170
	Conferring T171
INDEPENDENT/COLLABORATIVE
	Independent Reading T171
	Literacy Activities T171
	Collaboration T171

	
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T380–T381
»	Compose from a Point of View
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T381
	Conferences T378
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T384–T385
»	Compose an Event Sequence
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T385
	Conferences T378

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Final Stable 
Syllables T382
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	Language and Conventions: Spiral Review: Subject-Verb Agreement T383

	 WRITING BRIDGE	
	Spelling: Teach Words with Final Stable Syllables T386
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)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Explain Author’s Purpose T172–T173
»	Close Read: Trombone Shorty
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T173
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Make Connections T180–T181
»	Close Read: Trombone Shorty
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T181
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T188–T189
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T189
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Graphic Features T174–T175
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Final Stable Syllables 
T176–T177
	 READING BRIDGE	
	Write for a Reader: Use Graphic Features T182–T183
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: r-controlled Vowels T184–T185
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Final Stable Syllables 
T190–T191
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T190

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T178–T179
	Strategy and Intervention Activities T178
	Fluency T178
	ELL Targeted Support T178
	Conferring T179
INDEPENDENT/COLLABORATIVE
	Independent Reading T179
	Literacy Activities T179
	Partner Reading T179
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T186–T187
	Strategy and Intervention Activities T186
	Fluency T186
	ELL Targeted Support T186
	Conferring T187
INDEPENDENT/COLLABORATIVE
	Independent Reading T187
	Literacy Activities T187
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T192–T193
	Strategy, Intervention, and On-Level/
Advanced Activities T192
	ELL Targeted Support T192
	Conferring T193
INDEPENDENT/COLLABORATIVE
	Independent Reading T193
	Literacy Activities T193
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T193 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T388–T389
»	Compose Dialogue
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T389
	Conferences T378
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T392–T393
»	Plan Illustrations
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T393
	Conferences T378
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T396
»	Select a Genre
»	Share Back
INDEPENDENT WRITING
	Select a Genre T397
	Conferences T378

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Words with 
Final Stable Syllables T390
	Language and Conventions: Teach 
Irregular Verbs T391

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: r-controlled 
Vowels T394
	Language and Conventions: Practice Irregular Verbs T395

	 WRITING BRIDGE	
	Spelling: Spell Words with Final Stable Syllables T398
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn about fiction and read texts that help me compare and contrast point of view.
	I can develop knowledge about language 
to make connections between reading fiction and writing.
	I can use elements of narrative writing to write a realistic fiction story.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T198–T199
	Listening Comprehension: Read Aloud 
“To Trying New Things” T200–T201
	Fiction T202–T203
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T203
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Texts T212–T239
»	Preview Vocabulary
»	Read and Compare Texts
	Respond and Analyze T240–T241
»	My View
»	Develop Vocabulary 
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T241
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Figurative Language T204–T205
	Word Study: Teach Syllable Patterns V/CV and VC/V T206–T207
	 READING BRIDGE	
	Word Study: Apply Syllable Patterns 
V/CV and VC/V T242–T243

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T210–T211
	Strategy, Intervention, and On-Level/
Advanced Activities T210
	ELL Targeted Support T210
	Conferring T211
INDEPENDENT/COLLABORATIVE
	Independent Reading T211
	Literacy Activities T211
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T211 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T244–T245
	Strategy and Intervention Activities T244
	Fluency T244
	ELL Targeted Support T244
	Conferring T245
INDEPENDENT/COLLABORATIVE
	Independent Reading T245
	Literacy Activities T245
	Collaboration T245

	
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T404–T405
»	Use Irregular Verbs
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T405
	Conferences T402
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T408–T409
»	Edit for Punctuation
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T409
	Conferences T402

	
	 WRITING BRIDGE	
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	Spelling: V/CV and VC/V Words T406
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	Language and Conventions: Spiral Review: Irregular Verbs T407


	 WRITING BRIDGE	
	Spelling: Teach V/CV and VC/V Words T410
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Compare and Contrast Point of View 
T246–T247
»	Close Read: Weslandia and “The Circuit”
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T247
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Generate Questions T254–T255
»	Close Read: Weslandia and “The Circuit”
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T255
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T262–T263
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T263
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Author’s Purpose and Message T248–T249
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Syllable Patterns V/CV and VC/V T250–T251
	 READING BRIDGE	
	Write for a Reader: Use Author’s Purpose and Message T256–T257
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Final Stable Syllables T258–T259
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Syllable Patterns V/CV 
and VC/V T264–T265
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T264

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T252–T253
	Strategy and Intervention Activities T252
	Fluency T252
	ELL Targeted Support T252
	Conferring T253
INDEPENDENT/COLLABORATIVE
	Independent Reading T253
	Literacy Activities T253
	Partner Reading T253
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T260–T261
	Strategy and Intervention Activities T260
	Fluency T260
	ELL Targeted Support T260
	Conferring T261
INDEPENDENT/COLLABORATIVE
	Independent Reading T261
	Literacy Activities T261
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T266–T267
	Strategy, Intervention, and On-Level/
Advanced Activities T266
	ELL Targeted Support T266
	Conferring T267
INDEPENDENT/COLLABORATIVE
	Independent Reading T267
	Literacy Activities T267
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T267 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T412–T413
»	Edit for Prepositional Phrases
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T413
	Conferences T402
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T416–T417
»	Edit for Coordinating Conjunctions
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction T417
	Conferences T402
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T420
»	Use Pronouns
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T421 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T402

	 WRITING BRIDGE	
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	 WRITING BRIDGE	
	Spelling: Spell V/CV and VC/V Words T422
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about the theme Diversity 
by analyzing poetic elements.
	I can develop knowledge about language 
to make connections between reading 
and writing.
	I can use elements of narrative writing to write a realistic fiction story.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment
	Writing Workshop Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
	Writing Workshop Performance-Based Assessment
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T272–T273
	Listening Comprehension: Read Aloud “The Harvest” T274–T275
	Genre T276–T277
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T277
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T286–T293
»	Preview Vocabulary
»	Read: Poetry Collection
	Respond and Analyze T294–T295
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T295
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Parts of Speech T278–T279
	Word Study: Teach Silent Letters 
T280–T281
	 READING BRIDGE	
	Word Study: Apply Silent Letters 
T296–T297

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T284–T285
	Strategy, Intervention, and On-Level/
Advanced Activities T284
	ELL Targeted Support T284
	Conferring T285
INDEPENDENT/COLLABORATIVE
	Independent Reading T285
	Literacy Activities T285
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T285 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T298–T299
	Strategy and Intervention Activities T298
	Fluency T298
	ELL Targeted Support T298
	Conferring T299
INDEPENDENT/COLLABORATIVE
	Independent Reading T299
	Literacy Activities T299
	Collaboration T299


	
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T428–T429
»	Rearrange and Combine Ideas
»	Share Back	
INDEPENDENT WRITING
	Realistic Fiction Story T429
	Conferences T426
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T432–T433
»	Edit for Capitalization
»	Share Back	
INDEPENDENT WRITING
	Realistic Fiction Story T433
	Conferences T426

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Silent 
Letters T430
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	Language and Conventions: Spiral Review: Progressive Verb Tenses T431
	 WRITING BRIDGE	
	Spelling: Teach Words with Silent Letters T434
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Examine Poetic Elements T300–T301
»	Close Read: Poetry Collection
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T301
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Visualize to Understand T308–T309
»	Close Read: Poetry Collection
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	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T316–T317
»	Talk About It
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	 READING BRIDGE	
	Read Like a Writer: Analyze Literary Devices T302–T303
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
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	 READING BRIDGE	
	Write for a Reader: Use Literary Devices T310–T311
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	 READING BRIDGE	
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	Word Study: Silent Letters T318–T319
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	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T306–T307
	Strategy and Intervention Activities T306
	Fluency T306
	ELL Targeted Support T306
	Conferring T307
INDEPENDENT/COLLABORATIVE
	Independent Reading T307
	Literacy Activities T307
	Partner Reading T307
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T314–T315
	Strategy and Intervention Activities T314
	Fluency T314
	ELL Targeted Support T314
	Conferring T315
INDEPENDENT/COLLABORATIVE
	Independent Reading T315
	Literacy Activities T315

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T320–T321
	Strategy, Intervention, and On-Level/
Advanced Activities T320
	ELL Targeted Support T320
	Conferring T321
INDEPENDENT/COLLABORATIVE
	Independent Reading T321
	Literacy Activities T321
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	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T436–T437
»	Publish and Celebrate
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction Story T437
	Conferences T426
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T440–T441
»	Prepare for Assessment
»	Share Back
INDEPENDENT WRITING
	Realistic Fiction Story T441
	Conferences T426
	 WRITING WORKSHOP	
MINILESSON
	Realistic Fiction T444
»	Assessment
»	Share Back
INDEPENDENT WRITING
	Assessment T445
	Conferences T426

	 WRITING BRIDGE	
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	Spelling: More Practice: Words with 
Silent Letters T438
	Language and Conventions: Teach Auxiliary Verbs T439

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Syllable 
Patterns V/CV and VC/V T442
	Language and Conventions: Practice Auxiliary Verbs T443

	 WRITING BRIDGE	
	Spelling: Words with Silent Letters T446
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T446
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T447






 PROJECT FOCUS 	This week students will
• research the need for inclusive playground equipment.
• write a letter to the school principal arguing that inclusive 
play equipment should be on the school playground.

	 LESSON 1	
T452–T455W.4.2.d, W.4.7, SL.4.1, SL.4.1.c

	Compare Across Texts
•	Answer the Essential Question
	Inquire
•	Introduce Inquiry Project
•	Read “Playing Together”
•	Generate Questions
•	Use Academic Vocabulary

	
	
	

	 LESSON 2	
T456–T459RI.4.2, RI.4.7, W.4.7, W.4.8, SL.4.1.c

	Explore and Plan
•	Argumentative Writing
•	Read “Who Needs Recess?”
•	Claims and Evidence
	Conduct Research
•	Search Engines
•	Credibility of Sources

	
	
	

	 LESSON 3	
T460–T463W.4.1, W.4.1.a, SL.4.2, L.4.2.b, L.4.3.a

	Collaborate and Discuss
•	Read a Student Model
•	Identify Features of Argumentative Texts
	Refine Research
•	Plagiarism and Paraphrasing
•	Read “Understanding Physical Disabilities”
•	Apply Quoting and Paraphrasing

	
	
	

	 LESSON 4	
T464–T467RI.4.7, W.4.1.a, W.4.8, SL.4.1.c, L.4.1, L.4.2.d

	Extend Research
•	Incorporate Media
•	Brainstorm Media
	Collaborate and Discuss
•	Revise Word Choice
•	Edit for Conventions

	
	
	

	 LESSON 5	
T468–T469W.4.5, W.4.10, SL.4.1, SL.4.4

	Celebrate and Reflect
•	Share Letters
•	Reflect on the Project
	Reflect on the Unit
•	Reflect on your Goals
•	Reflect on your Reading
•	Reflect on your Writing
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UNIT THEME
Impacts
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	WEEK 3
	

	
	
	Traditional Literature
	
	Tall Tale
	
	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_3.png]Drama
	

	
	
	from Can You Guess My Name?
	
	Thunder Rose

	
	“La Culebra 
(The Snake)”
	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Minilesson 
Bank
	Media: Revealing Secrets
	RI.4.10
	Poem: But I Tried Out 
For . . .
	SL.4.1
	Fairy Tale: The Mysterious Mask
	RL.4.10

	
	
	Traditional Literature: Can You Guess My Name?
	RL.4.10
	Tall Tale: Thunder Rose
	RL.4.10
	Drama: “La Culebra 
(The Snake)”
	RL.4.10

	
	
	Words that provide clues to events and actions
	L.4.6
	Words that develop tone
	L.4.5
	Words that develop characters and connect the drama to the unit theme
	L.4.6

	
	
	Analyze Characters
	RL.4.3
	Infer Theme
	RL.4.2
	Explain Elements of a Drama
	RL.4.5

	
	
	Synthesize Information
	RL.4.3
	Make Connections
	RL.4.10
	Summarize Literary Text
	RL.4.2

	
	
	Talk About It
	SL.4.1
	Write to Sources
	W.4.9
	Write to Sources
	W.4.9.a

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.4.6
	Synonyms and Antonyms
	L.4.5.c
	Context Clues
	L.4.6

	
	
	Word Study
	Greek and Latin Prefixes
	RF.4.3.a
	Suffixes -able, -ible
	RF.4.3.a
	Syllable Pattern VV
	RF.4.3.a

	
	
	Read Like a Writer
	Analyze Voice
	RL.4.10
	Analyze Exaggeration
	RL.4.1
	Analyze Author’s Craft
	RL.4.10

	
	
	Write for a Reader
	Use Voice
	W.4.3
	Use Exaggeration
	W.4.3
	Develop Message
	W.4.3

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Analyze an Opinion Essay
	W.4.1
	Develop a Topic and Opinion
	W.4.1
	Compose the Introduction and Conclusion
	W.4.1.a

	
	
	Understand Point of View
	W.4.1
	Develop Reasons
	W.4.1.b
	Organize Reasons
	W.4.1

	
	
	Understand Reasons and Information
	W.4.1
	Develop Supporting Details and Facts
	W.4.1.b
	Organize Supporting Details
	W.4.1.b

	
	
	Brainstorm a Topic and Opinion
	W.4.1
	Compose a Concluding Statement
	W.4.1.d
	Use Transition Words and Phrases
	W.4.1.c

	
	
	Plan Your Opinion Essay
	W.4.1
	Compose Using Technology
	W.4.6
	Use Technology to Collaborate
	W.4.6

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Greek and Latin Word Parts
	L.4.2.d
	Spell Suffixes -able, -ible
	L.4.2.d
	Spell Syllable Pattern VV
	L.4.2.d

	
	
	Language and Conventions
	Pronouns
	L.4.1
	Adjectives
	L.4.1.d
	Adverbs
	L.4.1



 (
UNIT 
4
 
SKILLS OVERVIEW
)
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 (
Essential Question
)
How do our stories shape our world?
	WEEK 4
	
	WEEK 5
	

	Historical Fiction
	
	Myths
	

	The Secret of the Winter Count
	
	“Pandora” and “Race to the Top”
	

	
	CCSS
	
	CCSS

	Primary Source: StoryCorps
	RI.4.10
	Infographic: Texts that Guide Our Actions
	RI.4.10

	Historical Fiction: The Secret of the Winter Count
	RL.4.10
	Myths: “Pandora” and “Race to the Top”
	RL.4.10

	Words that help you understand the characters and events in the text
	L.4.6
	Words that help you identify and analyze elements of myth
	RL.4.4

	Infer Theme
	RL.4.2
	Analyze Myths
	RL.4.9

	Make Connections
	RL.4.10
	Evaluate Details
	RL.4.3

	Write to Sources
	W.4.9.a
	Talk About It
	SL.4.1.c

	Figurative Language
	L.4.5.b
	Parts of Speech
	L.4.4

	Prefixes im-, in-, ir-
	RF.4.3.a
	Homophones
	L.4.1.g

	Analyze Figurative Language and Mood
	RL.4.10
	Analyze Allusions
	RL.4.4

	Use Figurative Language and Mood
	W.4.3
	Use Allusions
	W.4.3

	Writer’s Craft
	Publish, Celebrate, and Assess

	Rearrange Ideas for Coherence and Clarity
	W.4.5
	Incorporate Peer and Teacher Suggestions
	W.4.1

	Combine Ideas for Coherence and Clarity
	W.4.1.a
	Publish a Final Draft
	W.4.1

	Peer Edit
	W.4.5
	Publish and Celebrate
	W.4.1

	Edit for Complete Sentences
	L.4.1.f
	Prepare for Assessment
	W.4.1

	Edit Nouns
	L.4.1.g
	Assessment
	W.4.1

	Spell Words with Prefixes
	L.4.2.d
	Spell Homophones
	L.4.2.d

	Comparative Adjectives
	L.4.1
	Superlative Adjectives
	L.4.1


	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_5.png]WEEK 6
	

	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_6.png][image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_4.png]Inquiry and Research
	

	The Tale Behind 
the Tale
	

	
	CCSS

	Leveled Research Articles
	RI.4.10

	Use Academic Words
	L.4.6

	Explore and Plan: Informational Text
	W.4.2

	Conduct Research: Library of Congress
	W.4.6

	Informational Text: Blog Post
	RI.4.10

	Refine Research: Bibliography
	W.4.8

	Extend Research: Media
Message
	W.4.2

	Revise Order of Ideas
	W.4.5

	Edit and Peer Review
	W.4.5

	Celebrate and Reflect
	W.4.2





 (
RL.4.10, RF.4.3.a, W.4.1.b, SL.4.1, L.4.4.b, L.4.6
 
) (
RL.4.1, RF.4.2, W.4.1, SL.4.1, L.4.4, L.4.4.b
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn about traditional literature by analyzing characters.
	I can use language to make connections between reading and writing.
	I can use elements of opinion writing to 
write an essay.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore Media: Weekly Question T18–T19
	Listening Comprehension: Read Aloud “The Princess and the Troll” T20–T21
	Traditional Literature T22–T23
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T23
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T32–T49
»	Preview Vocabulary
»	Read: from Can You Guess My Name?
	Respond and Analyze T50–T51
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T51
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T24–T25
	Word Study: Teach Greek and Latin Prefixes T26–T27
	 READING BRIDGE	
	Word Study: Apply Greek and Latin Prefixes T52–T53

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T30–T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T54–T55
	Strategy and Intervention Activities T54
	Fluency T54
	ELL Targeted Support T54
	Conferring T55
INDEPENDENT/COLLABORATIVE
	Independent Reading T55
	Literacy Activities T55
	Collaboration T55

	
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T344–T345
»	Analyze an Opinion Essay: 
Genre Immersion
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T345
	Conferences T342
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T348–T349
»	Understand Point of View: 
Genre Immersion
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T349
	Conferences T342

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Greek and Latin Word Parts T346
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T346
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Auxiliary Verbs T347

	 WRITING BRIDGE	
	Spelling: Teach Spell Greek and Latin Word Parts T350
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Pronouns T351
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 (
RL.4.9, RF.4.4.b, W.4.5, SL.4.1.b, SL.4.4, L.4.1
 
) (
RL.4.2, RL.4.3, RF.4.4, W.4.1.c, SL.4.1, L.4.3
) (
RL.4.9, RL.4.10, RF.4.4.a, W.4.1.d, SL.4.1, L.4.3
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Characters T56–T57
»	Close Read: from Can You Guess 
My Name?
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T57
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Synthesize Information About 
Characters T64–T65
»	Close Read: from Can You Guess 
My Name?
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T65
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T72–T73
	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T73
	Weekly Question


	 READING BRIDGE	
	Read Like a Writer: Analyze Voice T58–T59
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Greek and 
Latin Prefixes T60–T61
	 READING BRIDGE	
	Write for a Reader: Use Voice T66–T67
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Silent 
Letters T68–T69
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Greek and Latin 
Prefixes T74–T75
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T74

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T62–T63
	Strategy and Intervention Activities T62
	Fluency T62
	ELL Targeted Support T62
	Conferring T63
INDEPENDENT/COLLABORATIVE
	Independent Reading T63
	Literacy Activities T63
	Partner Reading T63
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T70–T71
	Strategy and Intervention Activities T70
	Fluency T70
	ELL Targeted Support T70
	Conferring T71
INDEPENDENT/COLLABORATIVE
	Independent Reading T71
	Literacy Activities T71
	Independent Reading T71

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T76–T77
	Strategy, Intervention, and On-Level/
Advanced Activities T76
	ELL Targeted Support T76
	Conferring T77
INDEPENDENT/COLLABORATIVE
	Independent Reading T77
	Literacy Activities T77
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T77 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T352–T353
»	Understand Reasons and Information
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T353
	Conferences T342
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T356–T357
»	Brainstorm a Topic and Opinion
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T357
	Conferences T342
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T360–T361
»	Plan Your Opinion Essay
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T361 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T342

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Spell Greek 
and Latin Word Parts T354
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Language and Conventions: 
Teach Pronouns T355
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Silent 
Letters T358
	Language and Conventions: 
Practice Pronouns T359

	 WRITING BRIDGE	
	Spelling: Spell Greek and Latin Word 
Parts T362
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T362
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T363






 (
RL.4.2, RF.4.3.a, W.4.1, W.4.1.b, SL.4.1, L.4.5
) (
RL.4.2, RF.4.3.a, W.4.1.a, W.4.1.b, SL.4.1, L.4.5.c
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about traditional literature 
by inferring theme.
	I can use language to make connections between reading and writing.
	I can use elements of opinion writing to 
write an essay
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Poem: Weekly Question T82–T83
	Listening Comprehension: Read Aloud “Pecos Bill and the Coyotes” T84–T85
	Tall Tales T86–T87
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T87
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T96–T111
»	Preview Vocabulary
»	Read: Thunder Rose
	Respond and Analyze T112–T113
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T113
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms and Antonyms T88–T89
	Word Study: Teach Suffixes -able, -ible T90–T91
	 READING BRIDGE	
	Word Study: Practice Suffixes 
-able, -ible T114–T115

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T94–T95
	Strategy, Intervention, and On-Level/
Advanced Activities T94
	ELL Targeted Support T94
	Conferring T95
INDEPENDENT/COLLABORATIVE
	Independent Reading T95
	Literacy Activities T95
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T95 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T116–T117
	Strategy and Intervention Activities T116
	Fluency T116
	ELL Targeted Support T116
	Conferring T117
INDEPENDENT/COLLABORATIVE
	Independent Reading T117
	Literacy Activities T117
	Partner Reading T117

	
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T368–T369
»	Develop a Topic and Opinion
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T369
	Conferences T366
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T372–T373
»	Develop Reasons
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T373
	Conferences T366

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Suffixes -able, -ible T370
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T370
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Pronouns T371


	 WRITING BRIDGE	
	Spelling: Teach Suffixes -able, -ible T374
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Adjectives T375
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 (
RL.4.2, RF.4.4, W.4.1.a, W.4.1.b, SL.4.1, L.4.5.
) (
RL.4.3, RL.4.10, RF.4.4.a, W.4.1.d, SL.4.1, L.4.1.d
 
) (
RL.4.10, RF.4.4.c, W.4.6, W.4.9, SL.4.1, L.4.3
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Infer Theme T118–T119
»	Close Read: Thunder Rose
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T119
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Make Connections T126–T127
»	Close Read: Thunder Rose
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T127
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T134–T135
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T135
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Exaggeration T120–T121
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Suffixes 
-able, -ible T122–T123
	 READING BRIDGE	
	Write for a Reader: Use Exaggeration T128–T129
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Greek and 
Latin Prefixes auto, anti, trans, amphi 
T130–T131
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Suffixes -able, -ible 
T136–T137
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T137

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T124–T125
	Strategy and Intervention Activities T124
	Fluency T124
	ELL Targeted Support T124
	Conferring T125
INDEPENDENT/COLLABORATIVE
	Independent Reading T125
	Literacy Activities T125
	Partner Reading T125
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T132–T133
	Strategy and Intervention Activities T132
	Fluency T132
	ELL Targeted Support T132
	Conferring T133
INDEPENDENT/COLLABORATIVE
	Independent Reading T133
	Literacy Activities T133
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T138–T139
	Strategy, Intervention, and On-Level/
Advanced Activities T138
	ELL Targeted Support T138
	Conferring T139
INDEPENDENT/COLLABORATIVE
	Independent Reading T139
	Literacy Activities T139
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T139 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T376–T377
»	Develop Supporting Details and Facts
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T377
	Conferences T366
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T380–T381
»	Compose a Concluding Statement
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T381
	Conferences T366
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T384
»	Compose Using Technology
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T385 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T366

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Suffixes 
-able, -ible T378
	Language and Conventions: 
Teach Adjectives T379

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Greek and 
Latin Word Parts auto, anti, trans, 
amphi T382
	Language and Conventions: 
Practice Adjectives T383


	 WRITING BRIDGE	
	Spelling: Suffixes -able, -ible T386
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T386
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: 
Standards Practice T387
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) (
RL.4.5, RL.4.7, RF.4.3, W.4.1.d, SL.4.1, L.4.4.a
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about the theme Impacts 
by identifying elements of a drama.
	I can use language to make connections between reading and writing.
	I can use elements of opinion writing to 
write an essay.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Fairy Tale: Weekly Question T144–T145
	Listening Comprehension: Read Aloud “Too Much of a Good Thing” T146–T147
	Drama T148–T149
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T149
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T158–T173
»	Preview Vocabulary
»	Read: “La Culebra (The Snake)”
	Respond and Analyze T174–T175
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T174
»	Check for Understanding T175

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues T150–T151
	Word Study: Teach Syllable Pattern 
VV T152–T153
	 READING BRIDGE	
	Word Study: Apply Syllable Pattern 
VV T176–T177
	High-Frequency Words T176

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T156–T157
	Strategy, Intervention, and On-Level/
Advanced Activities T156
	ELL Targeted Support T156
	Conferring T157
INDEPENDENT/COLLABORATIVE
	Independent Reading T157
	Literacy Activities T157
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T157 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T178–T179
	Strategy and Intervention Activities T178
	Fluency T178
	ELL Targeted Support T178
	Conferring T179
INDEPENDENT/COLLABORATIVE
	Independent Reading T179
	Literacy Activities T179
	Collaboration T179

	
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T392–T393
»	Compose the Introduction and Conclusion
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T393
	Conferences T390
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T396–T397
»	Organize Reasons
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T397
	Conferences T390

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Syllable Pattern 
VV T394
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T394
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Adjectives T395

	 WRITING BRIDGE	
	Spelling: Teach Spell Syllable Pattern 
VV T398
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Adverbs T399
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)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Explain Elements of a Drama T180–T181
»	Close Read: “La Culebra (The Snake)”
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T181
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Summarize Literary Texts T188–T189
»	Close Read: “La Culebra (The Snake)”
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T189
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T196–T197
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T197
»	Weekly Question T197

	 READING BRIDGE	
	Read Like a Writer: Analyze Author’s 
Craft T182–T183
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Syllable 
Pattern VV T184–T185
	 READING BRIDGE	
	Write for a Reader: Develop Message T190–T191
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Suffixes 
-able, -ible T192–T193
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Syllable Pattern VV 
T198–T199
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T199

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T186–T187
	Strategy and Intervention Activities T186
	Fluency T186
	ELL Targeted Support T186
	Conferring T187
INDEPENDENT/COLLABORATIVE
	Independent Reading T187
	Literacy Activities T187
	Independent Reading T187
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T194–T195
	Strategy and Intervention Activities T194
	Fluency T194
	ELL Targeted Support T194
	Conferring T195
INDEPENDENT/COLLABORATIVE
	Independent Reading T195
	Literacy Activities T195
	Partner Reading T195
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers
 T200–T201
	Strategy, Intervention, and On-Level/
Advanced Activities T200
	ELL Targeted Support T200
	Conferring T201
INDEPENDENT/COLLABORATIVE
	Independent Reading T201
	Literacy Activities T201
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T201 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T400–T401
»	Organize Supporting Details
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T401
	Conferences T390
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T404–T405
»	Use Transition Words and Phrases
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T405
	Conferences T390
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T408
»	Use Technology to Collaborate
»	Share Back
INDEPENDENT WRITING
	Select a Genre T409
	Conferences T390

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Spell Syllable Pattern VV T402
	Language and Conventions: Teach 
Adverbs T403

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Suffixes 
-able, -ible T406
	Language and Conventions: Practice Adverbs T407

	 WRITING BRIDGE	
	Spelling: Spell Syllable Pattern VV T410
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T410
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about the theme Impacts 
by inferring theme in historical fiction.
	I can use language to make connections between reading and writing.
	I can use elements of opinion writing to 
write an essay.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Primary Source: Weekly Question T206–T207
	Listening Comprehension: Read Aloud “Waiting for Pa” T208–T209
	Historical Fiction T210–T211
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T211 
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T220–T239
»	Preview Vocabulary
»	Read: The Secret of the Winter Count
	Respond and Analyze T240–T241
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T241
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Figurative Language T212–T213
	Word Study: Teach Prefixes im-, in-, 
ir- T214–T215
	 READING BRIDGE	
	Word Study: Apply Prefixes im-, in-, 
ir- T242–T243

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T218–T219
	Strategy, Intervention, and On-Level/
Advanced Activities T218
	ELL Targeted Support T218
	Conferring T219
INDEPENDENT/COLLABORATIVE
	Independent Reading T219
	Literacy Activities T219
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T219 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T244–T245
	Strategy and Intervention Activities T244
	Fluency T244
	ELL Targeted Support T244
	Conferring T245
INDEPENDENT/COLLABORATIVE
	Independent Reading T245
	Literacy Activities T245
	Collaboration T245

	
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T416–T417
»	Rearrange Ideas for Coherence and Clarity
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T417
	Conferences T414
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T420–T421
»	Combine Ideas for Coherence and Clarity
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T421
	Conferences T414

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Prefixes im-, in-,
 ir- T418
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	Language and Conventions: Spiral Review: Adverbs T419

	 WRITING BRIDGE	
	Spelling: Teach Spell Prefixes im-, in-, 
ir- T422
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Infer Theme T246–T247
»	Close Read: The Secret of the 
Winter Count
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T247
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Make Connections T254–T255
»	Close Read: The Secret of the 
Winter Count
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T255
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T262–T263
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T263
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Figurative Language and Mood T248–T249
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Prefixes 
im-, in-, ir- T250–T251
	 READING BRIDGE	
	Write for a Reader: Use Figurative Language and Mood T256–T257
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Syllable 
Pattern VV T258–T259
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Prefixes im-, in-, ir- 
T264–T265
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T264

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T252–T253
	Strategy and Intervention Activities T252
	Fluency T252
	ELL Targeted Support T252
	Conferring T253
INDEPENDENT/COLLABORATIVE
	Independent Reading T253
	Literacy Activities T253
	Partner Reading T253
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T260–T261
	Strategy and Intervention Activities T260
	Fluency T260
	ELL Targeted Support T260
	Conferring T261
INDEPENDENT/COLLABORATIVE
	Independent Reading T261
	Literacy Activities T261
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T266–T267
	Strategy, Intervention, and On-Level/
Advanced Activities T266
	ELL Targeted Support T266
	Conferring T267
INDEPENDENT/COLLABORATIVE
	Independent Reading T267
	Literacy Activities T267
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T267 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T424–T425
»	Peer Edit
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T425
	Conferences T414
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T428–T429
»	Edit for Complete Sentences
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T429
	Conferences T414
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T432
»	Edit Nouns
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T433 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T414

	 WRITING BRIDGE	
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	Spelling: More Practice: Spell Prefixes 
im-, in-, ir- T426
	Language and Conventions: Teach Comparative Adjectives T427

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Syllable 
Pattern VV T430
	Language and Conventions: Practice Comparative Adjectives T431

	 WRITING BRIDGE	
	Spelling: Spell Prefixes im-, in-, ir- T281
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T434
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)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about traditional literature 
by analyzing myths.
	I can use language to make connections between reading and writing.
	I can use elements of opinion writing to 
write an essay.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T272–T273
	Listening Comprehension: Read Aloud “Earth’s Tears” T274–T275
	Myths T276–T277
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T277 
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Texts T286–T305
»	Preview Vocabulary
»	Read and Compare Texts
	Respond and Analyze T306–T307
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T307
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Parts of Speech T278–T279
	Word Study: Teach Homophones 
T280–T281
	 READING BRIDGE	
	Word Study: Apply Homophones 
T308–T309

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T284–T285
	Strategy, Intervention, and On-Level/
Advanced Activities T284
	ELL Targeted Support T284
	Conferring T285
INDEPENDENT/COLLABORATIVE
	Independent Reading T285
	Literacy Activities T285
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T285 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T310–T311
	Strategy and Intervention Activities T310
	Fluency T310
	ELL Targeted Support T310
	Conferring T311
INDEPENDENT/COLLABORATIVE
	Independent Reading T311
	Literacy Activities T311
	Collaboration T311


	
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T440–T441
»	Incorporate Peer and Teacher Suggestions
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T441
	Conferences T438
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T444–T445
»	Publish a Final Draft
»	Share Back	
INDEPENDENT WRITING
	Opinion Essay T445
	Conferences T438

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Homophones T442
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T442
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	Language and Conventions: Spiral Review: Comparative Adjectives T443


	 WRITING BRIDGE	
	Spelling: Teach Homophones T446
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Myths T312–T313
»	Close Read: “Pandora” and “Race to 
the Top”
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T313
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Evaluate Details T320–T321
»	Close Read: “Pandora” and “Race to 
the Top”
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T321
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T328–T329
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T329
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Allusions T314–T315
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: 
Homophones T316–T317
	 READING BRIDGE	
	Write for a Reader: Use Allusions 
T322–T323
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	 READING BRIDGE	
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	Word Study: Homophones T330–T331
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	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T318–T319
	Strategy and Intervention Activities T318
	Fluency T318
	ELL Targeted Support T318
	Conferring T319
INDEPENDENT/COLLABORATIVE
	Independent Reading T319
	Literacy Activities T319
	Partner Reading T319
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T326–T327
	Strategy and Intervention Activities T326
	Fluency T326
	ELL Targeted Support T326
	Conferring T327
INDEPENDENT/COLLABORATIVE
	Independent Reading T327
	Literacy Activities T327

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T332–T333
	Strategy, Intervention, and On-Level/
Advanced Activities T332
	ELL Targeted Support T332
	Conferring T333
INDEPENDENT/COLLABORATIVE
	Independent Reading T333
	Literacy Activities T333
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T333 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T448–T449
»	Publish and Celebrate
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T449
	Conferences T438
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T452–T453
»	Prepare for Assessment
»	Share Back
INDEPENDENT WRITING
	Opinion Essay T453
	Conferences T438
	 WRITING WORKSHOP	
MINILESSON
	Opinion Essay T456
»	Assessment
»	Share Back
INDEPENDENT WRITING
	Assessment T457
	Conferences T438

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Homophones 
T450
	Language and Conventions: Teach Superlative Adjectives T451

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Prefixes 
im-, in-, ir- T454
	Language and Conventions: Practice Superlative Adjectives T455


	 WRITING BRIDGE	
	Spelling: Homophones T458
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T458
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T459






PROJECT FOCUS 	This week students will
• research the origin of an American tall tale.
• write an explanatory blog post. 

	 LESSON 1	
 (
RI.4.4, RF.4.4, W.4.7, SL.4.1, L.4.1
)T464–T467
	Compare Across Texts
•	Answer the Essential Question
	Inquire
•	Introduce the Project
•	Read “The Truth Behind the Legend”
•	Generate questions
•	Use Academic Vocabulary

	
	
	

	 LESSON 2	
 (
RI.4.2, RF.4.4.a, W.4.7, W.4.8, SL.4.5, L.4.3  
)T468–T471
	Explore and Plan
•	Informative Writing
•	Read “The Library of Congress”
•	Apply characteristics of text
	Conduct Research
•	Request information online
•	Use tools to research

	
	
	

	 LESSON 3	
 (
RF.4.4.b, W.4.8, SL.4.1, L.4.1
)T472–T475
	Collaborate and Discuss
•	Analyze Student Model
•	Identify features of an informational text
	Refine Research
•	Bibliography
•	Read “Who’s Your Hero?”
•	Develop a bibliography

	
	
	

	 LESSON 4	
 (
RF.4.4.c, W.4.10, SL.4.5, L.4.3
)T476–T479
	Extend Research
•	Create a strong media message
•	Incorporate language, images, and sounds into writing
	Collaborate and Discuss
•	Revise & Edit: Main Idea and Details
•	Peer review blog post

	
	
	

	 LESSON 5	
 (
SL.4.6, L.4.3.c
)T480–T481
	Celebrate and Reflect
•	Share your blog post
•	Reflect on your project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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	WEEK 3
	

	
	
	Informational Text
	
	Informational Text
	
	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_3.png]Argumentative Text
	

	
	
	from Planet Earth


	
	Volcanoes


	
	from The Top 10 Ways You Can Reduce Waste
	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Minilesson 
Bank
	Infographic: The Surface of Earth
	RI.4.7
	Media: Volcanic Activity
	RI.4.7
	Diagram: Pollutant Emissions
	RI.4.7

	
	
	Informational Text: from Planet Earth
	RI.4.10
	Informational Text: Volcanoes
	RI.4.10
	Argumentative Text: from The Top 10 Ways You Can Reduce Waste
	RI.4.10

	
	
	Words that help you understand ideas about Earth revealed in the text.
	L.4.6
	Words that help you form mental images of important topics or ideas from the text.
	L.4.6
	Words that clarify and support the author’s claim.
	L.4.6

	
	
	Analyze Text Features
	RI.4.7
	Analyze Main Idea and Details
	RI.4.2
	Analyze Argument
	RI.4.8

	
	
	Make Inferences
	RI.4.1
	Monitor Comprehension
	RI.4.10
	Summarize Argumentative Text
	RI.4.2

	
	
	Talk About It
	SL.4.1.c
	Write to Sources
	W.4.9
	Write to Sources
	W.4.9

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.4.5
	Synonyms and Antonyms
	L.4.5.c
	Context Clues
	L.4.4.a

	
	
	Word Study
	Latin Roots gener, port, dur, and ject
	RF.4.3.a
	Suffixes -en, -ent, -ence
	RF.4.3.a
	Syllable Pattern VCCCV
	RF.4.3.a

	
	
	Read Like a Writer
	Analyze Text Structure
	RI.4.5
	Understand Author’s Message
	RI.4.8
	Understand Literary Devices
	RI.4.10

	
	
	Write for a Reader
	Use Text Structure
	W.4.9.b
	Develop Author’s Message
	W.4.2
	Use Literary Devices
	W.4.4

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Understand Poetry
	W.4.4
	Compose a Rhythm
	W.4.4
	Compose with Line Breaks
	W.4.4

	
	
	Explore What Poetry Sounds Like
	W.4.4
	Compose with Alliteration and Assonance
	W.4.4
	Arrange Stanzas
	W.4.4

	
	
	Explore What Poetry Looks Like
	W.4.4
	Compose with Similes and Metaphor
	W.4.4
	Select Punctuation
	L.4.3.b

	
	
	Brainstorm Ideas
	W.4.5
	Compose with Rhyming Words
	W.4.4
	Set a Rhyme Scheme
	W.4.4

	
	
	Plan Your Poem
	W.4.5
	Use Repetition
	W.4.4
	Select a Genre
	W.4.4

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Words with Latin Roots
	L.4.2.d
	Spell Words with -en, -ent, 
-ence
	L.4.2.d
	Spell Words with Syllable Pattern VCCCV
	L.4.2.d

	
	
	Language and Conventions
	Relative Adverbs
	L.4.1.a
	Capitalization Rules
	L.4.2.a
	Title Capitalization
	L.4.2.a



 (
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Copyright © Savvas Learning Company LLC. All Rights Reserved.
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 (
Essential Question
)
Why is it important to understand our planet?
	WEEK 4
	
	WEEK 5
	

	Informational Text
	
	Informational Text
	

	The Himalayas


	
	Trashing Paradise and “Bye Bye Plastic Bags on Bali”
	

	
	CCSS
	
	CCSS

	Primary Source: Preserving Biodiversity
	RI.4.10
	Infographic: The Trouble with Ocean Trash
	RI.4.7

	Informational Text: The Himalayas
	RI.4.10
	Informational Text: Trashing Paradise and “Bye Bye Plastic Bags on Bali”
	RI.4.10

	Words that help you understand ideas related to Earth’s features.
	L.4.6
	Words that give precise information about key concepts.
	L.4.4.a

	Explain Ideas
	RI.4.3
	Compare and Contrast Accounts
	RI.4.6

	Make Inferences
	RI.4.1
	Use Text Evidence to Explain Concepts
	RI.4.1

	Write to Sources
	W.4.8
	Talk About It
	SL.4.1

	Figurative Language
	L.4.5.a
	Parts of Speech
	L.4.6

	Prefixes dis-, over-, 
non-, under-
	RF.4.3.a
	Word Parts sub-, inter-, fore-
	RF.4.3.a

	Analyze Author’s Use of Text Features
	RI.4.10
	Analyze Author’s Purpose
	RI.4.8

	Use Text Features
	W.4.2.a
	Develop Author’s Purpose
	W.4.2

	Writer’s Craft
	Publish, Celebrate, and Assess

	Use Verbs
	L.4.1.b
	Add and Delete Ideas for Coherence and Clarity
	L.4.3.a

	Revise for Structure
	W.4.5
	Prepare for the Celebration
	W.4.4

	Revise for Word Choice
	L.4.3.a
	Publish and Celebrate
	W.4.4

	Edit for Adjectives
	L.4.1.d
	Prepare for Assessment
	W.4.4

	Edit for Prepositional Phrases
	L.4.1.e
	Assessment
	W.4.4

	Spell Words with dis-, over-, non-, under-
	L.4.2.d
	Spell Words with sub-, 
inter-, fore-
	L.4.2.d

	Comma Rules
	L.4.2.c
	Dialogue Punctuation
	L.4.2.b
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	Danger Ahead!


	

	
	CCSS

	Leveled Research Articles
	RI.4.10

	Use Academic Words
	L.4.6

	Explore and Plan: Argumentative Text
	W.4.7

	Conduct Research: Expert Evidence
	W.4.8

	Argumentative Writing: Opinion Article
	W.4.1.a

	Refine Research: Primary and Secondary Sources
	W.4.7

	Extend Research: Online Archives
	W.4.7

	Revise Transitions
	W.4.5

	Edit and Peer Review
	W.4.5

	Celebrate and Reflect
	SL.4.4





 (
RI.4.3, RF.4.3.a, W.4.10, SL.4.1, L.4.4.b
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational text 
by analyzing text features.
	I can develop knowledge about language
 to make connections between reading and writing.
	I can use knowledge of the elements 
and structure of poetry to write a poem.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 (
RI.4.10, RF.4.3.3, W.4.10
,SL.4.1
, L.4.4.b
) LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T18–T19
	Listening Comprehension: Read Aloud “Energy Recovery of Waste” T20–T21
	Informational Text T22–T23
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T23
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T32–T45
»	Preview Vocabulary
»	Read: Planet Earth
	Respond and Analyze T46–T47
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T47
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T24–T25
	Word Study: Teach Latin Roots gener, port, dur, ject T26–T27
	 READING BRIDGE	
	Word Study: Apply Latin Roots gener, port, dur, ject T48–T49

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T30–T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T50–T51
	Strategy and Intervention Activities T50
	Fluency T50
	ELL Targeted Support T50
	Conferring T51
INDEPENDENT/COLLABORATIVE
	Independent Reading T51
	Literacy Activities T51
	Collaboration T51

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T336–T337
»	Understand Poetry: Genre Immersion
»	Share Back
INDEPENDENT WRITING
	Poetry T337
	Conferences T334
	 WRITING WORKSHOP	
MINILESSON
	Poetry T340–T341
»	Explore What Poetry Sounds Like: Genre Immersion
»	Share Back
INDEPENDENT WRITING
	Poetry T341
	Conferences T334

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Latin Roots gener, port, dur, 
ject T338
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T338
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Superlative Adjectives T339

	 WRITING BRIDGE	
	Spelling: Teach Latin Roots gener, port, dur, ject T342
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	Language and Conventions: Oral Language: Relative Adverbs T343
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Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
RI.4.10, RF.4.3, W.4.10
,SL.4.3
, L.4.1
) (
RI.4.10, RI.4.1, RF.4.10, W.4.10, SL.4.1, L.4.1.a
) (
RI.4.5, RF.4.3, W.4.10, SL.4.1, L.4.1.a
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Text Features T52–T53
»	Close Read: Planet Earth
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T53
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Make Inferences T60–T61
»	Close Read: Planet Earth
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T61
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T68–T69
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T69
»	Weekly Question


	 READING BRIDGE	
	Read Like a Writer: Analyze Text Structure T54–T55
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Latin Roots gener, port, dur, ject T56–T57
	 READING BRIDGE	
	Write for a Reader: Use Text Structure 
T62–T63
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: 
Homophones T64–T65
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Latin Roots gener, port, 
dur, ject T70–T71
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T70

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T58–T59
	Strategy and Intervention Activities T58
	Fluency T58
	ELL Targeted Support T58
	Conferring T59
INDEPENDENT/COLLABORATIVE
	Independent Reading T59
	Literacy Activities T59
	Partner Reading T59
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T66–T67
	Strategy and Intervention Activities T66
	Fluency T66
	ELL Targeted Support T66
	Conferring T67
INDEPENDENT/COLLABORATIVE
	Independent Reading T67
	Literacy Activities T67

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T72–T73
	Strategy, Intervention, and On-Level/
Advanced Activities T72
	ELL Targeted Support T72
	Conferring T73
INDEPENDENT/COLLABORATIVE
	Independent Reading T73
	Literacy Activities T73
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T73 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Poetry T344–T345
»	Explore What Poetry Looks Like
»	Share Back
INDEPENDENT WRITING
	Poetry T345
	Conferences T334
	 WRITING WORKSHOP	
MINILESSON
	Poetry T348–T349
»	Brainstorm Ideas
»	Share Back
INDEPENDENT WRITING
	Poetry T349
	Conferences T334
	 WRITING WORKSHOP	
MINILESSON
	Poetry T352
»	Plan Your Poem
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T353 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T334

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Latin Roots 
gener, port, dur, ject T346
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Language and Conventions: Teach Relative Adverbs T347
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: 
Homophones T350
	Language and Conventions: Practice Relative Adverbs T351

	 WRITING BRIDGE	
	Spelling: Latin Roots gener, port, dur, 
ject T354
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T354
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	Language and Conventions: Standards Practice T355






 (
RI.4.10, RF.4.3.a
,W.4.10
, SL.4.2, L.4.2.a
) (
RI.4.10, RF.4.3.a
,W.4.10
, SL.4.1, L.4.5.c
)
	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational text 
by analyzing the main, or central, idea 
and details.
	I can use language to make connections between reading and writing.
	I can use knowledge of the elements 
and structure of poetry to write a poem.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Media: Weekly Question T78–T79
	Listening Comprehension: Read Aloud “Mount Vesuvius” T80–T81
	Informational Text T82–T83
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T83
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T92–T105
»	Preview Vocabulary
»	Read: Volcanoes
	Respond and Analyze T106–T107
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T107
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms and Antonyms T84–T85
	Word Study: Teach Suffixes -en, -ent, 
-ence T86–T87
	 READING BRIDGE	
	Word Study: Apply Suffixes -en, -ent, 
-ence T108–T109

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T90–T91
	Strategy, Intervention, and On-Level/
Advanced Activities T90
	ELL Targeted Support T90
	Conferring T91
INDEPENDENT/COLLABORATIVE
	Independent Reading T91
	Literacy Activities T91
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T91 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T110–T111
	Strategy and Intervention Activities T110
	Fluency T110
	ELL Targeted Support T110
	Conferring T111
INDEPENDENT/COLLABORATIVE
	Independent Reading T111
	Literacy Activities T111
	Collaboration T111

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T360–T361
»	Compose a Rhythm
»	Share Back
INDEPENDENT WRITING
	Poetry T360
	Conferences T358
	 WRITING WORKSHOP	
MINILESSON
	Poetry T364–T365
»	Compose with Alliteration and Assonance
»	Share Back
INDEPENDENT WRITING
	Poetry T365
	Conferences T358

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with -en, -ent, -ence 
T362
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T362
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Relative Adverbs T363

	 WRITING BRIDGE	
	Spelling: Teach Words with -en, -ent,
 -ence T366
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Capitalization Rules T367
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RI.4.10, RF.4.3, W.4.2.d, W.4.9, L.4.1
) (
RI.4.10, RF.4.3, W.4.10, SL.4.2, L.4.2.a
) (
RI.4.8, RI.4.2, RF.4.3,
 
W.4.10, SL.4.2, L.4.2.a
)
	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Main Idea and Details T112 –T113
»	Close Read: Volcanoes
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T113
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Monitor Comprehension T120–T121
»	Close Read: Volcanoes
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T121
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T128–T129
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T129
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Understand Author’s Message T114–T115
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Suffixes 
-en, -ent, -ence T116–T117
	 READING BRIDGE	
	Write for a Reader: Develop Author’s Message T122–T123
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Latin Roots T124–T125
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Suffixes -en, -ent, 
-ence T130–T131
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T130

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T118–T119
	Strategy and Intervention Activities T118
	Fluency T118
	ELL Targeted Support T118
	Conferring T119
INDEPENDENT/COLLABORATIVE
	Independent Reading T119
	Literacy Activities T119
	Partner Reading T119
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T126–T127
	Strategy and Intervention Activities T126
	Fluency T126
	ELL Targeted Support T126
	Conferring T127
INDEPENDENT/COLLABORATIVE
	Independent Reading T127
	Literacy Activities T127
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T132–T133
	Strategy, Intervention, and On-Level/
Advanced Activities T132
	ELL Targeted Support T132
	Conferring T133
INDEPENDENT/COLLABORATIVE
	Independent Reading T133
	Literacy Activities T133
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T133 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Poetry T368–T369
»	Compose with Similes and Metaphors
»	Share Back
INDEPENDENT WRITING
	Poetry T369
	Conferences T358
	 WRITING WORKSHOP	
MINILESSON
	Poetry T372–T373
»	Compose with Rhyming Words
»	Share Back
INDEPENDENT WRITING
	Poetry T373
	Conferences T358
	 WRITING WORKSHOP	
MINILESSON
	Poetry T376
»	Use Repetition
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T377 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T358

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Words with 
-en, -ent, -ence T370
	Language and Conventions: Teach Capitalization Rules T371

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Latin 
Roots T374
	Language and Conventions: Practice Capitalization Rules T375

	 WRITING BRIDGE	
	Spelling: Words with -en, -ent, -ence T378
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T378
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	Language and Conventions: Standards Practice T379
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about the theme Features by analyzing the argument in an argumentative text.
	I can use language to make connections between reading and writing.
	I can use knowledge of the elements 
and structure of poetry to write a poem.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Diagram Weekly Question T138–T139
	Listening Comprehension: Read Aloud “The New Downtown” T140–T141
	Argumentative Text T142–T143
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T143
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T152–T173
»	Preview Vocabulary
»	Read: from The Top 10 Ways You Can Reduce Waste
	Respond and Analyze T174–T175
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T175
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues T144–T145
	Word Study: Teach Syllable Pattern VCCCV T146–T147
	 READING BRIDGE	
	Word Study: Apply Syllable Pattern VCCCV T176–T177

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T150–T151
	Strategy, Intervention, and On-Level/
Advanced Activities T150
	ELL Targeted Support T150
	Conferring T151
INDEPENDENT/COLLABORATIVE
	Independent Reading T151
	Literacy Activities T151
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T151 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T178–T179
	Strategy and Intervention Activities T178
	Fluency T178
	ELL Targeted Support T178
	Conferring T179
INDEPENDENT/COLLABORATIVE
	Independent Reading T179
	Literacy Activities T179
	Collaboration T179

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T384–T385
»	Compose with Line Breaks
»	Share Back
INDEPENDENT WRITING
	Poetry T385
	Conferences T382
	 WRITING WORKSHOP	
MINILESSON
	Poetry T388–T389
»	Arrange Stanzas
»	Share Back
INDEPENDENT WRITING
	Poetry T389
	Conferences T382

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Multisyllabic 
Words T386
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T386
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Capitalization Rules T387

	 WRITING BRIDGE	
	Spelling: Teach Spell Multisyllabic 
Words T390
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	Language and Conventions: Oral Language: Title Capitalization T391
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Analyze Argument T180–T181
»	Close Read: from The Top 10 Ways You Can Reduce Waste
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T181
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Summarize Argumentative Text T188–T189
»	Close Read: from The Top 10 Ways You Can Reduce Waste
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T189
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T196–T197
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T197
»	Weekly Question 

	 READING BRIDGE	
	Read Like a Writer: Understand Literary Devices T182–T183
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Syllable 
Pattern VCCCV T184–T185
	 READING BRIDGE	
	Write for a Reader: Use Literary Devices T190–T191
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Suffixes 
-en, -ent, -ence T192–T193
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Syllable Pattern 
VCCCV T198–T199
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T198

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T186–T187
	Strategy and Intervention Activities T186
	Fluency T186
	ELL Targeted Support T186
	Conferring T187
INDEPENDENT/COLLABORATIVE
	Independent Reading T187
	Literacy Activities T187
	Partner Reading T187
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T194–T195
	Strategy and Intervention Activities T194
	Fluency T194
	ELL Targeted Support T194
	Conferring T195
INDEPENDENT/COLLABORATIVE
	Independent Reading T195
	Literacy Activities T195

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T200–T201
	Strategy, Intervention, and On-Level/
Advanced Activities T200
	ELL Targeted Support T200
	Conferring T201
INDEPENDENT/COLLABORATIVE
	Independent Reading T201
	Literacy Activities T201
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T201 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Poetry T392–T393
»	Select Punctuation
»	Share Back
INDEPENDENT WRITING
	Poetry T393
	Conferences T382
	 WRITING WORKSHOP	
MINILESSON
	Poetry T396–T397
»	Set a Rhyme Scheme
»	Share Back
INDEPENDENT WRITING
	Poetry T397
	Conferences T382
	 WRITING WORKSHOP	
MINILESSON
	Poetry T400
»	Select a Genre
»	Share Back
INDEPENDENT WRITING
	Select a Genre T401
	Conferences T382

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: More Practice: Spell 
Multisyllabic Words T394
	Language and Conventions: Teach 
Title Capitalization T395

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with 
-en, -ent, -ence T398
	Language and Conventions: Practice 
Title Capitalization T399

	 WRITING BRIDGE	
	Spelling: Spell Multisyllabic Words T402
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T402
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	Language and Conventions: Standards Practice T403
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W.4.10, L.4.1.b, L4.1.c
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)
	 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational text 
by explaining ideas from a text.
	I can develop knowledge about language 
to make connections between reading 
and writing.
	I can use knowledge of the elements and structure of poetry to write a poem.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Primary Source: Weekly Question T206–T207
	Listening Comprehension: Read Aloud “Big Bend: Land of Contrasts” T208–T209
	Informational Text T210–T211
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T211 
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Text T220–T233
»	Preview Vocabulary
»	Read: The Himalayas
	Respond and Analyze T234–T235
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T235
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Figurative Language T212–T213
	Word Study: Teach Prefixes dis-, over-, non-, under- T214–T215
	 READING BRIDGE	
	Word Study: Apply Prefixes dis-, over-, non-, under- T236–T237
	High-Frequency Words T236

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T218–T219
	Strategy, Intervention, and On-Level/
Advanced Activities T218
	ELL Targeted Support T218
	Conferring T219
INDEPENDENT/COLLABORATIVE
	Independent Reading T219
	Literacy Activities T219
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T219 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T238–T239
	Strategy and Intervention Activities T238
	Fluency T238
	ELL Targeted Support T238
	Conferring T239
INDEPENDENT/COLLABORATIVE
	Independent Reading T239
	Literacy Activities T239
	Collaboration T239

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T408–T409
»	Use Verbs
»	Share Back
INDEPENDENT WRITING
	Poetry T409
	Conferences T406
	 WRITING WORKSHOP	
MINILESSON
	Poetry T412–T413
»	Revise for Structure
»	Share Back
INDEPENDENT WRITING
	Poetry T413
	Conferences T406

	
	 WRITING BRIDGE	
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	Spelling: Words with dis-, over-, non-, under- T410
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	Language and Conventions: Spiral Review: Title Capitalization T411

	 WRITING BRIDGE	
	Spelling: Teach Words with dis-, over-, non-, under- T414
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Explain Ideas T240–T241
»	Close Read: The Himalayas
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T241
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Make Inferences T248–T249
»	Close Read: The Himalayas
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T249
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share T256–T257
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T257
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Author’s 
Use of Text Features T242–T243
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Prefixes 
dis-, over-, non-, under- T244–T245
	 READING BRIDGE	
	Write for a Reader: Use Text Features T250–T251
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Spiral Review: Syllable 
Pattern VCCCV T252–T253
	 READING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: Prefixes dis-, over-, non-, under- T258–T259
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T258

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T246–T247
	Strategy and Intervention Activities T246
	Fluency T246
	ELL Targeted Support T246
	Conferring T247
INDEPENDENT/COLLABORATIVE
	Independent Reading T247
	Literacy Activities T247
	Partner Reading T247
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T254–T255
	Strategy and Intervention Activities T254
	Fluency T254
	ELL Targeted Support T254
	Conferring T255
INDEPENDENT/COLLABORATIVE
	Independent Reading T255
	Literacy Activities T255
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T260–T261
	Strategy, Intervention, and On-Level/
Advanced Activities T260
	ELL Targeted Support T260
	Conferring T261
INDEPENDENT/COLLABORATIVE
	Independent Reading T261
	Literacy Activities T261
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	 WRITING WORKSHOP	
MINILESSON
	Poetry T416–T417
»	Revise for Word Choice
»	Share Back
INDEPENDENT WRITING
	Poetry T417
	Conferences T406
	 WRITING WORKSHOP	
MINILESSON
	Poetry T420–T421
»	Edit for Adjectives
»	Share Back
INDEPENDENT WRITING
	Poetry T421
	Conferences T406
	 WRITING WORKSHOP	
MINILESSON
	Poetry T424
»	Edit for Prepositional Phrases
»	Share Back
INDEPENDENT WRITING
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	Conferences T406

	 WRITING BRIDGE	
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	Spelling: More Practice: Words with 
dis-, over-, non-, under- T418
	Language and Conventions: Teach 
Comma Rules T419

	 WRITING BRIDGE	
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	Spelling: Spiral Review: Syllable 
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	 WRITING BRIDGE	
	Spelling: Words with dis-, over-, non-, under- T426
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	Suggested Daily Times
READING WORKSHOP
SHARED READING	35–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	20–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about informational text 
by explaining concepts in a text.
	I can use language to make connections between reading and writing.
	I can use knowledge of the elements and structure of poetry to write a poem.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Writing Workshop Assessment
The following assessments are available on SavvasRealize.com:
	Progress Check-Ups
	Cold Reads
	Weekly Standards Practice for Language 
and Conventions
	Weekly Standards Practice for Word Study
	Weekly Standards Practice for Academic Vocabulary
	Practice Tests
	Test Banks
	Writing Workshop Performance-Based Assessment
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T266–T267
	Listening Comprehension: Read Aloud “The Footprints Across Earth’s Back” T268–T269
	Informational Text and Video T270–T271
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T271
	 LESSON 2 
 READING WORKSHOP	
SHARED READ
	Introduce the Texts T280–T297
»	Preview Vocabulary
»	Read and Compare Texts
	Respond and Analyze T298–T299
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T299
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Parts of Speech T272–T273
	Word Study: Teach Word Parts 
sub-, inter-, fore- T274–T275
	 READING BRIDGE	
	Word Study: Apply Word Parts 
sub-, inter-, fore- T300–T301

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T278–T279
	Strategy, Intervention, and On-Level/
Advanced Activities T278
	ELL Targeted Support T278
	Conferring T279
INDEPENDENT/COLLABORATIVE
	Independent Reading T279
	Literacy Activities T279
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T279 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers 
T302–T303
	Strategy and Intervention Activities T302
	Fluency T302
	ELL Targeted Support T302
	Conferring T303
INDEPENDENT/COLLABORATIVE
	Independent Reading T303
	Literacy Activities T303
	Collaboration T303

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T432–T433
»	Add and Delete Ideas for Coherence and Clarity
»	Share Back
INDEPENDENT WRITING
	Poetry T433
	Conferences T430
	 WRITING WORKSHOP	
MINILESSON
	Poetry T436–T437
»	Prepare for the Celebration
»	Share Back	
INDEPENDENT WRITING
	Poetry T437
	Conferences T430

	
	 WRITING BRIDGE	
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	Spelling: Spell Words with sub-, inter-, fore- T434
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	Language and Conventions: Spiral Review: Comma Rules T435

	 WRITING BRIDGE	
	Spelling: Teach Spell Words with sub-, inter-, fore- T438
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	Language and Conventions: Oral Language: Dialogue Punctuation T439
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	 LESSON 3 
 READING WORKSHOP	
CLOSE READ
	Compare and Contrast Accounts 
T304–T305
»	Close Read: Trashing Paradise and 
“Bye Bye Plastic Bags on Bali”
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T305
	 LESSON 4 
 READING WORKSHOP	
CLOSE READ
	Use Text Evidence to Explain Concepts T312–T313
»	Close Read: Trashing Paradise and 
“Bye Bye Plastic Bags on Bali”
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T313
	 LESSON 5 
 READING WORKSHOP	
COMPARE TEXTS
	Reflect and Share Collaboration T320–T321
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T321
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer: Analyze Author’s Purpose T306–T307
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Word Study: More Practice: Word 
Parts sub-, inter-, fore- T308–T309
	 READING BRIDGE	
	Write for a Reader: Develop Author’s Purpose T314–T315
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	Word Study: Spiral Review: Prefixes 
dis-, over-, non- under- T316–T317
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 PROJECT FOCUS 	This week students will
• research information about extreme weather.
• write an opinion article about the most dangerous 
environmental event.
	
	 LESSON 1	
T456–T459RI.4.9, W.4.7,  SL.4.5

	Compare Across Texts
•	Answer the Essential Question
	Inquire
•	Introduce Inquiry Project
•	Read “Warning! Warning!”
•	Generate questions
•	Use Academic Vocabulary

	
	
	

	 LESSON 2	
T460–T463RI.4.2, W.4.7, W.4.8, W.4.9.b

	Explore and Plan
•	Argumentative Writing
•	Read “Too Tied to Technology?”
•	Claims and evidence
	Conduct Research
•	Sources of evidence
•	Emails to experts

	
	
	

	 LESSON 3	
T464–T467RI.4.8, W.4.8,  SL.4.1

	Collaborate and Discuss
•	Read a Student Model
•	Identify features of opinion articles
	Refine Research
•	Primary and secondary sources
•	Read “Living Near a Volcano”
•	Classify sources in an article

	
	
	

	 LESSON 4	
T468–T471RI.4.10, W.4.9,  SL.4.1

	Extend Research
•	Using online archives
•	Possible archives for article
	Collaborate and Discuss
•	Revise claims and evidence
•	Edit for conventions

	
	
	

	 LESSON 5	
T472–T473RI.4.10, SL.4.6, L.4.3.c

	Celebrate and Reflect
•	Share your articles
•	Reflect on your work
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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